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Product overview

This chapter presents an overview of the hardware components of the HP xw4600 Workstation,
including the following topics:
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●

Product features on page 2

●

Workstation specifications on page 7

●

ENERGY STAR on page 13

●

Dual- and quad-core processors on page 14

●

HP Cool Tools on page 14

1

Product features
The following sections describe the HP xw4600 Workstation system board architecture and
components.

System board architecture
The following figure shows the HP xw4600 Workstation system board block diagram.
Figure 1-1 System board block diagram

Workstation components
The following figure shows the components of a typical HP xw4600 Workstation. Drive configurations
can vary.

2
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See http://partsurfer.hp.com for current information on supported spare parts.
Figure 1-2 Workstation components view

Table 1-1 Component view
Item

ENWW

Description

Item

Description

1

Power supply

9

Processor

2

Hard drive

10

Memory module

3

Optical drive

11

System board

4

Side access panel

12

PCI Express card

5

System fan

13

PCI card

6

Chassis

14

Speaker

7

Diskette drive

15

Front bezel

8

Processor heatsink

Product features
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Front panel components
The following figure shows the front panel components of a typical HP xw4600 Workstation. Drive
configurations can vary.
Figure 1-3 Front panel components

Table 1-2 Front panel components
Item

4

Symbol

Description

Item

Symbol

Description

1

Optical drive eject button

8

IEEE-1394 Connector (optional)

2

Power on light

9

Diskette drive eject button

3

Power button

10

Diskette drive activity light

4

Hard drive activity light

11

Diskette drive (optional)

5

USB 2.0 (2)

12

5.25–inch drive bays (2)

6

Headphone connector

13

Optical drive activity light

7

Microphone connector

14

Optical drive

Chapter 1 Product overview
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Rear panel components
The following figure shows the rear panel components of a typical HP xw4600 Workstation.
Figure 1-4 Rear panel components

Table 1-3 Rear panel components
Item

Symbol

Description

Item

Symbol

Description

1

Power supply Built-In Self Test (BIST)
LED

10

Padlock loop

2

Universal chassis clamp opening

11

Graphics adapter

3

PS/2 mouse connector (green)

12

eSATA adapter

4

Parallel connector (red)

13

USB 2.0 (1)

5

USB 2.0 (4)

14

USB 2.0 (2)

6

Audio line-in connector (blue)

15

Microphone connector (pink)

7

Audio line-out connector (green)

16

Serial connector (blue-green)

8

RJ-45 network connector

17

PS/2 keyboard connector

9

Cable lock slot

18

Power cord connector

NOTE: The rear panel connectors are labeled with industry-standard icons and colors to assist you in
connecting your peripheral devices.
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Serial number and COA label location
Each workstation has two unique serial number labels (1) and a Certificate of Authentication (COA) label
(2) (for Microsoft® Windows® preinstalled systems only). The serial number labels can usually be found
on the top panel or on the side or rear of the workstation. Keep this number available when contacting
customer service for assistance.
Figure 1-5 Location of serial number and COA label

Maximizing the airflow
●

Keep your workstation in an area where the airflow is not obstructed.

●

Keep the workstation off of surfaces where dust can gather.

●

Keep the front of the workstation clear of any obstruction.

●

Remove any dust on the front panel (vent area) and the rear fans with a small vacuum, compressed
air, or dust rag.

●

Keep the back of the workstation at least 0.15 m (6 in.) away from a wall or other obstruction.

Figure 1-6 Maintain proper clearance

6

Chapter 1 Product overview

ENWW

Workstation specifications
The following table lists the physical characteristics of the HP xw4600 Workstation.
Table 1-4 Physical characteristics
Weight (typical
configuration)

16 kg (35 lb.)

Tower dimensions

45 cm (17.7 in.) high
16.8 cm (6.6 in.) wide
45.6 cm (17.9 in.) deep

80 Plus power supply
The HP xw4600 Workstation includes a 475W energy efficient 80 Plus® power supply compatible with
Energy Star requirements. This section describes the power supply and lists its specifications.
Table 1-5 Power supply source voltages
Source voltage

Description

+3.3V

PCI, PCI Express, audio, CK505, ICH9R, super I/O, BIOS ROM, and
onboard logic

+5.1V

Storage (hard drive, optical drive, diskette drive), PCI, PCI Express, ICH9R,
audio, keyboard/mouse

+12 V–B

PCI, PCI Express, and system fans

+12 V-D

Storage (hard drive, optical drive, diskette drive), PCI Express x16 auxiliary
connector

+12 VCPU
-12V
+5 VSB

Input to onboard regulator that supplies power to the processor.
PCI, serial ports
Sleep circuitry

Table 1-6 Maximum current per rail
Voltage rail

ENWW

Maximum continuous current

+3.3V

15A

+5.1V

21A

+12 VCPU

15A

+12 V-B

17.5A

+12 V-D

12A

-12V

0.3A

+5 VSB

2.25A

Workstation specifications
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WARNING! Do not exceed 110W of 5-V and 3.3-V power combination.
Do not exceed 34.5A (414W) of 12V (CPU/B/D) power combination.
Do not exceed 475W of total continuous output power.

Power supply specifications
Table 1-7 Power supply specifications
Item

Description

Power supply

475 watt custom power supply – (Wide
Ranging, Active PFC)

Operating voltage range

90 – 269 VAC

Rated voltage range

100–240 VAC

118 VAC

Rated line frequency

50–60 Hz

400 Hz

Operating line frequency range

47–66 Hz

393–407 Hz

Rated input current

10A @ 100-127 VAC

10A @ 118 VAC

6A @ 200–240 VAC
Heat dissipation

Typical 1419 BTU/hr = (358 kg-cal/hr)

(Configuration and software dependent)

Maximum 2027 BTU/hr = (511 kg-cal/hr)

Power supply fan

92x25 mm variable speed

ENERGY STAR 4.0 compliant

Yes

80 Plus compliant

Yes

FEMP Standby Power compliant @115V (<2W in
S5 – Power Off)

Yes

Power Consumption in ES Mode – Suspend to
RAM (S3) (Instantly Available PC)

< 5W

Power consumption and cooling
This section lists the energy consumption and heat dissipation figures for three typical workstation
configurations.
NOTE: To reach zero power consumption, unplug the workstation from the power outlet or use a power
strip with an on/off switch. For additional information about power-saving features, see your operating
system documentation.
NOTE:

This product is in compliance with U.S. Executive Order 13221, WOL (wake on LAN) disabled.

Power supply example configuration 1
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●

One 2.20-GHz Intel® Pentium™ Dual Core E4500 processor

●

Two 512-MB 667-MHz memory modules

●

Nvidia NVS290 graphics card

Chapter 1 Product overview
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●

One 160-GB SATA hard drive

●

One optical drive

●

One diskette drive

●

One monitor, powered separately

Table 1-8 Power supply example configuration 1 energy consumption
115 VAC
LAN
Disabled

LAN
Enabled

230 VAC
LAN
Enabled

100 VAC

LAN
Disabled

LAN
Enabled

LAN
Disabled

Windows Idle (S0)

67.4W

66.4W

65.5W

Windows Busy Typ (S0)

89.7W

88.4W

88.2W

Windows Busy Max (S0)

114.1W

109.6W

110.0W

Sleep (S3)*

3.61W

2.82W

3.89W

3.12W

3.61W

2.82W

Power Off (S5)

1.51W

1.30W

1.81W

1.60W

1,50W

1.28W

* ENERGY STAR low energy mode.

Table 1-9 Power supply example configuration 1 heat dissipation**
115 VAC
LAN
Enabled

LAN
Disabled

230 VAC
LAN
Enabled

LAN
Disabled

100 VAC
LAN
Enabled

LAN
Disabled

Windows Idle (S0)

230.1 BTU/hr

226.6 BTU/hr

223.6 BTU/hr

Windows Busy Typ (S0)

306.3 BTU/hr

301.6 BTU/hr

300.9 BTU/hr

Windows Busy Max (S0)

389.4 BTU/hr

374.1 BTU/hr

375.4 BTU/hr

Sleep (S3)*

12.3 BTU/hr

9.62 BTU/hr

13.3 BTU/hr

10.6BTU/hr

12.3 BTU/hr

9.62 BTU/hr

Power Off (S5)

5.15 BTU/hr

4.44 BTU/hr

6.18 BTU/hr

5.46 BTU/hr

5.12 BTU/hr

4.37 BTU/hr

* ENERGY STAR low energy mode.
** Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

NOTE: To reach zero power consumption, unplug the workstation from the power outlet or use a power
strip with a switch. For additional information on power-saving features, see your operating system
documentation.
Power supply example configuration 2
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●

One 3.0 -GHz Intel® Core™ 2 Extreme QX6850 processor

●

Two 1-GB 800-MHz memory modules

●

Nvidia FX1700 graphics card

●

Two 73-GB SAS hard drives

Workstation specifications
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●

2 optical drives

●

1 diskette drive

Table 1-10 Power supply example configuration 2 energy consumption
115 VAC
LAN
Enabled

LAN
Disabled

230 VAC
LAN
Enabled

100 VAC

LAN
Disabled

LAN
Enabled

LAN
Disabled

Windows Idle (S0)

113W

108W

113W

WindowsBusy Typ (S0)

138W

133W

138W

Windows Busy Max (S0)

186W

178W

183W

Sleep (S3)*

3.70W

2.90W

3.95W

3.20W

3.70W

2.90W

Power Off (S5)

1.52W

1.30W

1.81W

1.58W

1.50W

1.28W

* ENERGY STAR low energy mode.

Table 1-11 Power supply example configuration 2 heat dissipation**
115 VAC
LAN
Enabled

LAN
Disabled

230 VAC
LAN
Enabled

100 VAC

LAN
Disabled

LAN
Enabled

LAN
Disabled

Windows Idle (S0)

386 BTU/hr

369 BTU/hr

386 BTU/hr

Windows Busy Typ (S0)

471 BTU/hr

454 BTU/hr

471 BTU/hr

Windows Busy Max (S0)

635 BTU/hr

608 BTU/hr

625 BTU/hr

Sleep (S3)*

12.6 BTU/hr

9.89 BTU/hr

13.5 BTU/hr

10.9 BTU/hr

12.6 BTU/hr

9.89 BTU/hr

Power off (S5)

5.19 BTU/hr

4.44 BTU/hr

6.18 BTU/hr

5.39 BTU/hr

5.12 BTU/hr

4.37 BTU/hr

* ENERGY STAR low energy mode
** Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

Power supply example configuration 3
●

One 3.0-GHz Intel® Pentium™ Dual Core E6850 processor

●

Two 1-GB 667-MHz memory modules

●

Nvidia FX1700 graphics card

●

Two 160-GB SATA hard drives

●

1 optical drives

Table 1-12 Power supply Example configuration 3 energy consumption

On-idle, ENERGY STAR

10
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115 VAC

230 VAC

100 VAC

76.3W

75.3W

76.6W

ENWW

Table 1-12 Power supply Example configuration 3 energy consumption (continued)
115 VAC

230 VAC

100 VAC

162.3W

159.6W

163.2W

3.7W

4.1W

3.8W

1.5W

1.8W

1.5W

Idle (S0)
ENERGY STAR Ptec (Total energy
consumption)
Windows running Linpack and
Viewperf
ENERGY STAR
Sleep (S3)*
ENERGY STAR
Standby (Off) (S5)
i1

* ENERGY STAR low energy mode

Table 1-13 Power supply example configuration 3 heat dissipation**

On-idle, ENERGY STAR

115 VAC

230 VAC

100 VAC

260 BTU/hr

257 BTU/hr

261 BTU/hr

554 BTU/hr

545 BTU/hr

557 BTU/hr

12.6 BTU/hr

14.0 BTU/hr

13.0 BTU/hr

5.12 BTU/hr

6.14 BTU/hr

5.12 BTU/hr

Idle (S0)
ENERGY STAR Ptec (Total energy
consumption)
Windows running Linpack and
Viewperf
ENERGY STAR
Sleep (S3)*
ENERGY STAR
Standby (Off) (S5)
* ENERGY STAR low energy mode
** Heat dissipation is calculated based on the measured watts, and assumes that the service level is attained for one hour.

System fans
This workstation includes one rear system fan, one processor heatsink fan, and one power supply fan.
In addition, an optional front system fan is available for special environments, and some graphics cards
include onboard fans.
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Resetting the power supply
If an overload triggers the power supply overload protection, all power is immediately disconnected. To
reset the power supply:
1.

Disconnect the power cord from the workstation..

2.

Determine what caused the overload and fix the problem. See System diagnostics and
troubleshooting on page 109 for troubleshooting information.

3.

Reconnect the power cord and reboot the workstation.

When you power off the workstation through the operating system, power consumption falls below what
is considered low power consumption, but does not reach zero. This low power consumption feature
extends the life of the power supply.

Environmental specifications
This section describes the environmental specifications of your workstation.
Table 1-14 Environmental specifications
Temperature (operating)

5° to 35°C (40° to 95°F)

Temperature (nonoperating)

-40° to 60°C (-40° to 140°F)

Humidity (operating)

8% to 85% RH, noncondensing

Humidity (nonoperating)

8% to 90% RH, noncondensing

Altitude (operating)

0 to 3,048m (10,000 ft)

Altitude (nonoperating)

0 to 9,144m (30,000 ft)

Shock (operating)

1/2-sine: 40G, 2–3 ms

Shock (nonoperating)

1/2-sine: 160 cm/s, 2–3 ms (~100g)
Square: 20G, 422 cm/s
NOTE: Values represent individual shock events and are not
indicative of repetitive shock events.

Vibration (operating)

Operating random: 0.5G (rms), 5–300 Hz

Vibration (nonoperating)

Random: 2.0G (rms), 10–500 Hz
NOTE: Values are not indicative of continuous vibration.
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ENERGY STAR
HP computers marked with the ENERGY STAR logo are compliant with the applicable U.S.
Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA
ENERGY STAR logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, HewlettPackard Company has determined the products marked with the ENERGY STAR logo are ENERGY
STAR qualified per the applicable ENERGY STAR guidelines for energy efficiency. The following logo
appears on all ENERGY STAR qualified computers.
Figure 1-7 ENERGY STAR logo

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. One way
products achieve this energy efficiency is by reducing power consumption when not being used through
the Microsoft Windows Power Management feature.
The Power Management feature enables the workstation to enter a low-power (or “sleep”) mode after
a period of inactivity. When used with an external monitor that is ENERGY STAR compliant, this feature
also supports the monitor's similar power management features.
To take advantage of this energy savings:
●

The Power Management feature has been preset to power down the computer after 30 minutes of
inactivity.

●

The Power Management feature has been preset to power down the monitor after 15 minutes of
inactivity.

Both the computer and monitor can be woken from “sleep” mode through user interaction with any of
the computer input devices (mouse, keyboard, and so on). When configured with Wake On LAN (WOL)
enabled, the workstation can also be awoken by a network signal.
See the EPA ENERGY STAR Power Management Web site for more information about the energy and
financial savings potential of the Power Management Feature: http://www.energystar.gov/
powermanagement.
See the EPA ENERGY STAR Web site for more information about the ENERGY STAR program and
its environmental benefits: http://www.energystar.gov.
CAUTION: Using the Energy Save Monitor feature with monitors that are not ENERGY STAR
compliant can cause video distortion when an Energy Save timeout occurs.
NOTE:

ENERGY STAR is not supported on Linux workstations.

If it is necessary to restore the operating system, you must also reset the ENERGY STAR settings (if
applicable) after the restore.
To verify the factory default power settings for your workstation, select Start>Control Panel and doubleclick Power Options.
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Dual- and quad-core processors
The HP xw4600 Workstation supports dual- and quad-core processors that provide two or four true
processors in a single socket. Dual- and quad-core processors are better at handling the load of multithreaded applications (such as rendering images in Digital Content Creation) and highly multi-tasked
environments (such as running several productivity applications while listening to music).

HP Cool Tools
HP xw4600 Workstation includes additional software preloaded that is not automatically installed when
you first boot your system. Additionally, there are a number of preinstalled tools on your workstation that
can enhance your workstation experience. To access or learn more about these applications:
●

Open the HP Cool Tools folder by selecting Start>All Programs>HP Cool Tools.

●

Select the HP Cool Tools icon on the desktop.

To learn more about these applications, select HP Cool Tools—Learn More.
To install or launch the applications, select the appropriate application.
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Configuring and restoring the operating
system

This chapter describes how to install and restore the operating system and includes the following topics.
●

Setting up Microsoft Windows Vista Business software on page 15

●

Setting up Microsoft Windows XP Professional on page 18

●

Protecting your software on page 22

●

HP software on page 22

●

Setting up Red Hat Linux on page 23

If your workstation includes a preinstalled operating system, it is configured automatically the first time
you power on the workstation.
CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

Setting up Microsoft Windows Vista Business software
This section describes how to install and restore Microsoft Windows Vista® Business on your
workstation.

Configuring the Windows Vista Business operating system
This section describes how to configure the Windows Vista Business operating system on your HP
workstation.

Configuring the software
When you first power on the workstation, the operating system is configured. Configuration takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the
configuration.
CAUTION: After the automatic configuration has begun, do not power off your workstation until this
process is complete. Powering off your workstation during the process might damage the software that
runs the system.
If it is necessary to reinstall the operating system, see the operating system documentation included
with your workstation. Additional information is available from the online help tool after you have
successfully configured the operating system.
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Selecting a language
When the preinstalled operating system is first booted, you might be prompted to select a language for
the operating system. After selecting the language, read and follow the instructions on the screen
to complete the installation of the operating system. This process might take a while, depending on the
system hardware configuration and the language choice. During the process, do not power off your
workstation unless you are prompted to do so.
After you have selected a language during the initial boot of the operating system, the language is locked
on the hard drive. If the system is restored using HP Backup and Recovery, only the previously selected
language can be installed. If using RestorePlus! DVDs, the RestorePlus! DVD looks for the language
stored on the hard drive and restores only the original preinstalled language. If a new hard drive is
installed or no language is found on the disk, the RestorePlus! DVD installs any language requested.

Creating recovery disks
For more information about the HP Backup and Recovery, see Restoring the Windows Vista Business
operating system on page 16.

Installing or upgrading device drivers
To install hardware devices after the operating system installation is complete, the appropriate device
drivers must be installed before the devices are installed. In addition, for optimum performance, your
operating system must have the most recent updates, patches, and software fixes. For driver and
software updates, access the following resources:
●

The Microsoft Web site provides updates for your operating system, including current patches and
software fixes.

●

Device drivers are provided on CDs supplied with peripheral devices.

●

Some peripheral device drivers developed for Windows XP or Vista might not be included with your
workstation. Current device drivers are available at http://www.hp.com/support/
workstation_swdrivers.

●

Driver installation and workstation operation documentation is available at http://www.hp.com/
support/workstation_manuals/.

Restoring the Windows Vista Business operating system
There are several methods to restore the Windows Vista Business operating system on your workstation
to a near-factory state, or to the state of the system at a predefined restore point. Your workstation has
a recovery partition on the system hard drive that contains the software and data required for the restore
process as described in the following sections.
If you must restore the operating system with Windows Vista Business Original Equipment Manufacturer
(OEM) DVDs (that is, installing without using the Restore Plus! DVDs), you must call Microsoft and
provide your Stock Keeping Unit (SKU) number. The SKU information is listed on the service tag. It
appears as the OS product number in the lower right hand portion of the tag in this format: “OS:
XXXXXXX,” where “XXXXXXX” is the OS product number.

Using the HP Backup and Restore process
The Windows operating system and device drivers (for devices included with the system) are reinstalled
using the HP Backup and Restore (HPBR) process. This process can be executed from a DVD, CD, or
from the recovery partition on your system hard drive.
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To launch the HPBR, slect Start>All Programs>HP Backup & Recovery>HP Backup and Recovery
Manager.
CAUTION: Before you attempt any operating system restore, backup your data . All data on the
Windows partition is deleted when you perform a system restore using the HPBR process. However,
the recovery partition on the system drive and other partitions will not be affected.
Creating system recovery DVDs or CDs
You can create a set of system recovery DVDs or CDs if you have a writable optical drive. After launching
the HP Backup and Restore Manager, you can create International Standards Organization (ISO)
images of the factory image, or write them directly to CD or DVD. You can also create a supplemental
HP Backup and Recovery Manager CD. (There may be additional CDs you can create depending on
the options purchased.) You can also move CD images to another location, such as a network share,
or to be copied to a DVD or CD at a later time or from another system.
Restoring from HPBR DVDs or CDs
To start the system recovery process, boot from the DVD or CD you created previously, then carefully
follow the online instructions.
Restoring a system directly from the recovery partition
Follow these steps to start the HPBR system restore process from the Recovery Manager:
1.

Boot the workstation.

2.

When prompted on the boot splash screen to enter the Recovery Manager, press F11.

3.

Follow the prompts to restore the system to factory-like condition.

Reclaiming hard drive space from the recovery partition
To free up hard drive space, you can remove only the recovery partition, or you can completely uninstall
the HP Backup and Recovery Manager application.
CAUTION:

If the recovery partition is removed:

– The F11 Emergency Recovery function becomes unavailable.
– The ability to recover the system is lost.
– Any recovery images contained in the recovery partition are deleted.
– The ability to create a recovery media set is lost.
CAUTION: If you uninstall the HP Backup and Recovery Manager application, emergency recovery
and data backup and recovery are no longer possible.
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●

Removing only the recovery partition—The recovery partition can be removed by selecting
Remove HP Recovery Partition from the HP Backup and Recovery program folder. When the
HP Recovery Partition is removed, the recovery partition is deleted, the user partition is extended
to reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP Backup and
Recovery Manager application remains and can be used for data backup and restore.

●

Uninstalling the HP Backup and Recovery Manager application—The HP Backup and
Recovery Manager application can be uninstalled using the Programs and Features utility under
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Windows Control Panel>Programs and Features. When the application is uninstalled, the
recovery partition is deleted, the user partition is extended to reclaim the unused space, and the
F11 boot prompt is removed. After the application is uninstalled, emergency recovery and data
backup and recovery can no longer be performed.
CAUTION: Deleting the recovery partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

Ordering backup software
If you are unable to create system recovery CDs or DVDs, you can order a recovery disk set from the
HP support center. Before calling HP to order the software, have your workstation serial number
available.
To obtain the support center telephone number for your region:
1.

Go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2.

Select your region.

3.

Under the Call HP heading, select Technical support after you buy.

Transferring files and settings using Windows Easy Transfer
Windows Easy Transfer, a Microsoft data migration tool, provides a guide that helps you choose what
files and data to transfer from another Windows computer to your Windows Vista Business workstation
and explains how to transfer it. You can use one of the following interconnect or storage methods with
Windows Easy Transfer to migrate data from another Windows computer to your workstation:
●

Network—can be used when both the source computer and your workstation are connected to the
same network.

●

Easy Transfer cable—a specially designed USB cable that connects the source computer to your
workstation when performing a Windows Easy Transfer. While an Easy Transfer cable is not a
standard USB cable, it is commonly available from local electronics suppliers.

●

DVDs or CDs—can be used if you have writeable DVD or CD drives on the source computer and
your workstation.

●

USB flash drive or an external hard drive—can access both the source computer and your
workstation.

To use the Windows Easy Transfer tool, select Start>All Programs>Accessories>System
Tools>Windows Easy Transfer.
NOTE: For more information about using Windows Easy Transfer with your workstation, see
http://www.microsoft.com/windows/products/windowsvista/features/details/easytransfer.mspx.

Setting up Microsoft Windows XP Professional
This section describes how to configure and restore Microsoft® Windows XP™ Professional on your
workstation.
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Configuring Windows XP Professional
This section describes how to configure Windows XP on your workstation.
When you first power on to the workstation, the operating system is configured. Configuration takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the
configuration.
CAUTION: After configuration begins, do not power off your workstation until the process is complete.
Powering off your workstation during the configuration process might damage the software that runs the
system.
If it is necessary to reinstall the operating system, see the operating system documentation included
with your workstation. Additional information is available from the online help tool after you have
successfully configured the operating system.

Selecting a language
When the preinstalled operating system is first booted, you might be prompted to select a language for
the operating system. After selecting the language, read and follow the instructions on the screen
to complete the installation of the operating system. This process might take quite a while, depending
on the system hardware configuration and the language choice. During the process, do not power off
your workstation unless you are prompted to do so.
NOTE: After you have selected a language during the initial boot of the operating system, the language
is locked on the hard drive. If the system is restored using HP Backup and Recovery, only the previously
selected language can be installed. If using RestorePlus! DVDs, the RestorePlus! DVD looks for the
language stored on the hard drive and restores only the original preinstalled language. If a new hard
drive is installed, or no language is found on the disk, the RestorePlus! DVD installs any language
requested.

Creating recovery disks
Refer to or Restoring the Windows XP Professional operating system on page 20 for details on the
HP Backup and Recovery process.

Installing or upgrading device drivers
To install hardware devices after the operating system installation is complete, the appropriate device
drivers must be installed before the devices are installed. In addition, for optimum performance, your
operating system must have the most recent updates, patches, and software fixes. For driver and
software updates, access the following resources:
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●

The Microsoft Web site provides updates for your operating system, including current patches and
software fixes.

●

Device drivers are provided on CD supplied with peripheral devices.

●

Some peripheral device drivers developed for Windows XP or Vista might not be included with your
workstation. Current device drivers are available at: http://www.hp.com/support/.

●

For documentation on installing drivers and workstation operation, see http://www.hp.com/support/
workstation_manuals/.
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Restoring the Windows XP Professional operating system
There are several methods to restore the Windows XP operating system on your workstation to a nearfactory state, or to the state of the system at a predefined snapshot in time. Your workstation has a
recovery partition on the system hard drive that contains the software and data required for the restore
process as described in the following sections.

The RestorePlus! process
The Windows operating system and device drivers (for devices included with the system) are reinstalled
using the RestorePlus! process. Some application software might not be restored using this process. If
specific application software was not restored, you must install the application software from the
appropriate application CD. The RestorePlus! process can be executed from a CD or from the recovery
partition on your system hard drive.
CAUTION: Before you attempt any operating system restore, back up your data . All data on the
Windows partition is deleted when you perform a system restore using the RestorePlus! process.
However, the recovery partition on the system drive and other partitions are not affected.
Creating a RestorePlus! CD
You can create a set of the system recovery CDs if you have a writable optical drive. When you first
boot the workstation, you are prompted to create CDs for RestorePlus!, the Windows operating system,
and a supplemental HP Backup and Recovery Manager. (There might be additional CDs you can create,
depending on the options purchased.) You also have the option to move CD images to another location,
such as a network share, to be copied to CD at a later time, or from another system.
Restoring your system from RestorePlus! CDs
Start the RestorePlus! process by booting from the RestorePlus! CD.
Restoring your system from RestorePlus! on the recovery partition
Follow these steps to start the RestorePlus! process from the Emergency Recovery menu:
1.

Boot the workstation.

2.

When prompted during the boot process to select the Emergency Recovery menu, press F11 . The
F11 prompt appears briefly during the boot process.
If you have a recovery partition but the F11 prompt is not visible:

3.
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a.

To access the setup menu, press F10. (See Using the Computer Setup (F10) Utility
on page 28 for details.)

b.

From the drop down menu, select Advanced.

c.

Select Power-On Options.

d.

Ensure that the F11 prompt is set to Displayed.

e.

Ensure that Factory Recovery Boot Support is set to Enabled.

f.

Reboot the workstation and press F11 when prompted.

Select Recover PC’s factory installed operating system, drivers, utilities, and applications
from the Emergency Recovery menu.
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NOTE:

Some applications might not be restored using this method.

Reclaiming hard drive space from the recovery partition
The recovery partition can be removed to reclaim the hard drive space.
CAUTION:

If the recovery partition is removed:

- The F11 Emergency Recovery function becomes unavailable.
- The ability to recover the system from data on the recovery partition is lost.
- Any recovery images contained in the recovery partition are deleted.
- The ability to create a recovery media set is lost.
To free up hard drive space, you can remove only the recovery partition, or you can completely uninstall
the HP Backup and Recovery Manager application.
CAUTION: If you uninstall the HP Backup and Recovery Manager application, Emergency Recovery
and data backup and recovery can no longer be performed.
●

Removing only the recovery partition—The recovery partition can be removed by selecting
Remove HP Recovery Partition from from the HP Backup and Recovery program folder. When
the HP Recovery Partition is removed, the recovery partition is deleted, the user partition is
extended to reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP
Backup and Recovery Manager application remains, and can be used for data backup and restore.

●

Uninstalling the HP Backup and Recovery Manager application—The HP Backup and
Recovery Manager application can be uninstalled using the Programs and Features utility under
Windows Control Panel>Programs and Features. When the application is uninstalled, the
recovery partition is deleted, the user partition is extended to reclaim the unused space, and the
F11 boot prompt is removed. After the application is uninstalled, emergency recovery as well as
data backup and recovery can no longer be performed.

CAUTION: Deleting the recovery partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

Using the HP Backup and Restore process
The Windows operating system and device drivers (for devices included with the system) are reinstalled
using the HP Backup and Restore (HPBR) process. This process can be executed from a DVD, CD, or
from the recovery partition on your system hard drive.
To launch the HPBR, slect Start>All Programs>HP Backup & Recovery>HP Backup and Recovery
Manager.
CAUTION: Before you attempt any operating system restore, backup your data . All data on the
Windows partition is deleted when you perform a system restore using the HPBR process. However,
the recovery partition on the system drive and other partitions will not be affected.
Creating system recovery DVDs or CDs
You can create a set of system recovery DVDs or CDs if you have a writable optical drive. After launching
the HP Backup and Restore Manager, you can create International Standards Organization (ISO)
images of the factory image, or write them directly to CD or DVD. You can also create a supplemental
HP Backup and Recovery Manager CD. (There may be additional CDs you can create depending on
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the options purchased.) You can also move CD images to another location, such as a network share,
or to be copied to a DVD or CD at a later time or from another system.
Restoring from HPBR DVDs or CDs
To start the system recovery process, boot from the DVD or CD you created previously, then carefully
follow the online instructions.
Restoring a system directly from the recovery partition
Follow these steps to start the HPBR system restore process from the Recovery Manager:
1.

Boot the workstation.

2.

When prompted on the boot splash screen to enter the Recovery Manager, press F11 .

3.

Follow the prompts to restore the system to factory-like condition.

Ordering backup software
If you are unable to create system recovery CDs or DVDs, you can order a recovery disk set from the
HP support center.
NOTE:

Before calling HP to order the software, have your workstation serial number available.

To obtain the support center telephone number for your region:
1.

Visit http://www.hp.com/support/contactHP.

2.

Select your region.

3.

Under the Call HP heading, select Technical support after you buy.

Protecting your software
To protect your software from loss or damage, keep a backup copy of all system software and related
files stored on the hard drive. For instructions on making backup copies of data files, see the operating
system or backup utility documentation.

HP software
The following HP software might be installed on your workstation, depending on the operating system
and options purchased:
●

Computer Setup (F10) Utility and diagnostics

●

HP support software, including device drivers

●

Security management tools (optional)

●

Software support management tools

Additional software is available for download:
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●

HP Client Manager Software is available at http://www.hp.com/go/easydeploy

●

System Software Manager is available at http://www.hp.com/go/ssm
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NOTE:

In certain situations, additional HP software might be required

Setting up Red Hat Linux
This section describes how to install and restore the Red Hat Linux operating system on your
workstation.

Linux preinstalled workstations
With Linux preinstalled, follow the instructions in this section to set up your operating system and
software.
After the boot process is complete, you can view additional HP Linux documentation by opening your
Web browser (the browser is automatically set to use the local HP documentation page as its default).
You can also access Linux links for Red Hat (Internet access is required) by using your Web browser.
For additional information about setting up Linux-preinstalled or Linux-enabled workstations, see the
HP User Manual for Linux at: http://www.hp.com/support/linux_user_manual.
For more information about HP and Linux, see http://www.hp.com/linux.

Starting the Linux operating system
The first time you boot your workstation, the Red Hat First Boot utility displays. This program enables
you to enter your password, network, graphics, time, and keyboard settings for your workstation.
CAUTION: After the automatic installation has begun, do not power down your workstation until the
process is complete. Powering down your workstation during the installation process might damage the
software that runs your workstation or prevent its proper installation.
When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you might get a blank
screen for approximately 15–30 seconds after you have selected and saved all of your settings and
exited the utility. This behavior is expected. The boot process continues its execution after the screen
returns.

Restoring the Linux operating system on preloaded workstations
The HP Driver CD and Red Hat Enterprise Linux (RHEL) restore media are required to restore the Linux
operating system. Download the most recent HP Driver CD to obtain new enhancements.
NOTE: Linux does not support mixed drive types in a manufacturing preload. When restoring the
operating system, mixed drive types can be handled with the restoration media.
Creating restore media
HP Red Hat Enterprise Linux includes a Red Hat ISO icon on the desktop. You can click on this icon to
go to the /iso directory. The /iso directory contains all the iso images used to preload your workstation.
To recover or restore the original image, follow the instructions in the readme file in the /iso directory to
copy the ISO image file onto CDs
NOTE: HP recommends that you copy the ISO recovery images to CD as backup files in case your
workstation experiences a hard drive failure.
The /iso directory also contains an ISO image of the HP Driver CD used to create your preloaded system.
You can use this version or download the latest version from the HP Website.
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Downloading the latest HP driver CD contents
To download the latest HP Driver CD:
1.

Go to http://www.hp.com and select Software and Drive Downloads.

2.

Locate your workstation and operating system.

3.

Select your driver CD and then follow the directions under the Release Notes.

Reinstalling the factory Linux image with the HP driver CD
1.

Boot your workstation from the Red Hat box set, Binary CD 1.

2.

When prompted, insert the Linux operating system restore media CDs.

3.

Continue following the installation prompts until the operating system is successfully installed.

4.

Configure the X server to start on reboot.

5.

Reboot your workstation.

6.

Follow the onscreen prompts to set up your system with the Red Hat First Boot utility.

7.

When prompted by First Boot to add additional CDs, insert the HP Driver CD into the optical drive
of your workstation.

8.

Select Install next to Additional CDs. The HP Driver CD window opens.

9.

To begin the installation, select Press to continue.
When installation is complete, you are given two options— Reboot now... (on the left side), and
Press to continue, reboot later... (on the right side).

10. Select Reboot now...

Upgrading device drivers
To upgrade a Linux device driver, see http://www.hp.com/support/workstation_swdrivers.

Linux-enabled workstations
Linux-enabled workstations do not have Linux preinstalled, nor do they include installation media for a
Linux distribution. To install Linux, you must have the installation binary set for a Linux distribution (CD
or DVD media, or a version on your network), and the HP Installer Kit for Linux. The HP Installer kit
includes the HP CDs necessary to complete the installation of all versions of the distribution box set that
are supported by HP workstation hardware. See the Linux hardware support matrix at
http://www.hp.com/support/linux_hardware_matrix to determine which versions of are supported on
your workstation.
NOTE: If you want to use the drivers available in the HP Installer kit with Linux distributions other than
RHEL, you must manually extract the drivers from the HP Driver CD and install them. HP does not test
the installation of these drivers on other Linux distributions, nor does HP support this type of operation.
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Verifying hardware compatibility
To determine which Linux versions are supported on your HP workstation hardware:
1.

See http://www.hp.com/support/linux_hardware_matrix.

2.

Select your HP workstation model.

Setting up Red Flag Linux
Hewlett-Packard offers the Red Flag Linux operating system as a preloaded option on the HP xw4600
Workstation in certain countries, but HP does not support the Red Flag Linux operating system. For
more information about Red Flag Linux and the Red Flag operating system software, see
http://www.redflag-linux.com.
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3

System management

This section describes the various tools and utilities that provide system management for your
workstation and includes the following topics:
●

Computer Setup (F10) Utility on page 27

●

Workstation management on page 35

Computer Setup (F10) Utility
The Computer Setup (F10) Utility enables you to:
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●

Change factory default settings and set or change the system configuration, which might be
necessary when you add or remove hardware.

●

Determine if all of the devices installed on the workstation are recognized by the system and
functioning properly.

●

Determine information about the operating environment of the workstation.

●

Solve system configuration errors that are detected but not automatically fixed during the PowerOn Self-Test (POST).

●

Establish and manage passwords and other security features.

●

Establish and manage energy-saving time-outs (not supported on Linux platforms).

●

Modify or restore factory default settings.

●

Set the system date and time.

●

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

●

Modify the boot order of installed mass storage devices such as SATA, SAS, diskette drives, optical
drives, network drives, and LS-120 drives.

●

Configure the boot priority of SATA and SAS hard-drive controllers.

●

Enable or disable Network Server Mode, that enables the workstation to boot the operating system
when the power-on password is enabled with or without a keyboard or mouse attached. When
attached to the system, the keyboard and mouse remain locked until the power-on password is
entered.

●

Select POST Messages Enabled or Disabled to change the display status of POST messages.
POST Messages suppresses most POST messages, such as memory count, product name, and
other non-error text messages. If a POST error occurs, the error is displayed regardless of the
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mode selected. To manually switch to POST Messages Enabled during POST, press any key
except F1 through F12.
●

Establish an Ownership Tag, the text of which is displayed each time the system is powered on or
restarted.

●

Enter the Asset Tag or property identification number assigned by your company to this
workstation.

●

Enable power-on password prompts during system restarts (warm-boots) and power on.

●

Hide or show the integrated I/O functionality, including serial, USB, or parallel ports, audio, or
embedded NIC. Any hidden devices are inaccessible which increases overall system security.

●

Enable or disable removable media boot ability.

●

Enable or disable removable media write ability (if supported by hardware).

●

Replicate your system setup by saving system configuration information on CD or diskette and
restoring it on one or more workstations.

●

Execute self-tests on specified SATA and SAS hard drives (if supported by the drive).

BIOS ROM
The BIOS ROM is a collection of machine language programs stored as firmware in ROM. It includes
functions such as POST, PCI device initialization, Plug and Play support, power management, and the
Computer Setup (F10) Utility. The BIOS ROM is a 1-MB Serial Peripheral Interface (SPI) port. The
firmware contained in the BIOS ROM supports the following systems and specifications:
●

Microsoft Windows Hardware Quality Labs (WHQL)

●

Alert-On-LAN (AOL) and Wake-On-LAN (WOL)

●

Advanced Configuration and Power Interface (ACPI) 1.0 and OnNow

●

System Management BIOS (SMBIOS) 2.3.5

●

PC98/99/00 and NetPC

●

Preboot Execution Environment (PXE) boot ROM for the integrated LAN controller

●

BIOS Boot Specification 1.01

●

Enhanced Disk Drive Specification 3.0

●

“El Torito” Bootable CD Format Specification 1.0

●

AT Attachment Packet Interface (ATAPI) Removable Media Device BIOS Specification 1.0

●

Multiprocessor Specification (MPS) 1.4 (for booting Linux SMP)

Using the Computer Setup (F10) Utility
You can only open the Computer Setup (F10) Utility by powering on or restarting the workstation.
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To access the Computer Setup (F10) Utility menu:
1.

Power on or restart the workstation.

2.

As soon as your display is active and F10=Setup appears in the lower right corner of the screen,
press the F10 key .
NOTE: If you do not press F10 at the appropriate time, try again. Turn the workstation off, then
on, and press F10 again to access the utility. You can also press the Ctrl + Alt + Delete keys before
boot if you miss the opportunity to press F10.

3.

Select your language from the list and press the Enter key. In the Computer Setup (F10) Utility
menu, five headings are displayed: File, Storage, Security, Power, and Advanced.

4.

Use the left and right arrow keys to select the appropriate heading. Use the up and down arrow
keys to select an option, and then press Enter.

5.

To apply and save changes, select File>Save Changes, and then select F10=YES.
●

If you have made changes that you do not want applied, select Ignore Changes and then
select F10=YES.

●

To reset to factory settings, select File>Default setup>Restore Factory Settings as
Default. Press F10 to accept the changes. Select Apply Defaults and Exit. This option
restores the original factory system defaults.

CAUTION: Do not power off the workstation while the ROM is saving your Computer Setup (F10)
Utility changes because the Complementary Metal-Oxide Semiconductor (CMOS) could become
corrupted. After you exit the F10 Setup screen, it is safe to disconnect power from the workstation.

Computer Setup (F10) Utility menu
NOTE: With new BIOS releases, the following content is subject to change , so your menu might
appear different than shown.
Table 3-1 Computer Setup (F10) Utility menu descriptions
Heading
File
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Option
System
Information

Description
●

Product Name

●

SKU Number

●

Processor Type/Speed/Stepping

●

Cache Size (L1/L2)

●

Installed Memory Size

●

Integrated MAC

●

System BIOS

●

Chassis Serial Number

●

Asset Tracking Number

About

Displays copyright information.

Set Time and
Date

Enables you to set system time and date.

Computer Setup (F10) Utility
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option
Flash System
ROM

Description
CD-ROM—Enables you to upgrade the BIOS from a ROM image on a CD.
USB—Enables you to upgrade the BIOS from a ROM image on a USB drive or memory stick.

Replicated
Setup

Save to Removable Media—Saves the system configuration, including CMOS, in the qsetup.txt
file. This file can be saved to a formatted, blank 1.44-MB diskette, or to a USB device.
Restore from Removable Media—Restores the system configuration from a diskette.

Default Setup

Save Current Settings as Default—Saves the current settings as default settings for the next
operation.
Restore Factory Settings as Default—Restores the factory settings as the default settings for the
next operation.

Storage

Apply Defaults
and Exit

Restores factory default settings.

Ignore Changes
and Exit

Exits computer setup without applying or saving any changes.

Save Changes
and Exit

Saves changes to system configuration and exits the computer setup.

Device
Configuration

Lists all installed nonSCSI storage devices (except SATA devices) and provides options for
obtaining specific information about each device.
Hard Disk—Provides information about the hard disk drives in the system.
CD-ROM—Provides information about the optical drives in the system.
Diskette Type (for legacy diskette drives only)— Identifies the highest capacity media type
accepted by the diskette drive. Options are 3.5" (1.44 MB), 5.25" (1.2 MB), and Not Installed.
Default Values—Resets devices to their default configuration (SATA is the default).
Multisector Transfers options are 8, 16, and Disable (16 is the default).
Transfer Mode specifies the active data transfer mode. Options (which are subject to device
capabilities) are: Max UDMA, PIO 0, Max PIO, Enhanced DMA, and Ultra DMA0 (Max UDMA is
the default).
Translation Mode enables the BIOS to automatically determine the translation mode used to
configure a previously formatted SATA or USB mass storage device. This prevents you from having
to know how the mass storage device was previously formatted.
Ordinarily, the translation mode selected automatically by the BIOS should not be changed. If the
selected translation mode is not compatible with the translation mode that was active when the
drive was partitioned and formatted, the data on the disk is inaccessible.
Translation Mode Options are: Automatic, Bit Shift, LBA Assisted, Use (Cylinders, Heads, Sectors),
and Off (Automatic is default).

Storage Options

Removable Media Boot—Enables and disables the ability to boot the system from removable
media.
Legacy Diskette Write—Enables and disables the ability to write data to removable media.
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description
SATA Emulation—Sets the SATA emulation mode with the following options:
●

RAID–RAID OPROM executes. This emulation mode offers the best performance and most
functionality.

●

IDE–Offers standard SATA support (four ports only).

●

AHCI–Offers full SATA and SATA-II functionality with no support for RAID.

DPS Self-test

Enables you to select a drive test for a SATA drive. It is not displayed by default and not available
for RAID and AHCI configurations.

Boot Order

Enables you to configure the boot, diskette drive, and hard drive orders by physically reordering
the menu entries. The default boot order presents the following selections:
●

Optical Drive

●

Diskette Drive

●

USB Device

●

Hard Drive

●

Broadcom Ethernet controller

Press Enter to drag a device to a preferred place. Press F5 to remove the device from consideration
as a bootable device.
NOTE: MS-DOS drive lettering assignments might not apply after an operating system other than
MS-DOS has started.
Boot devices can be disabled in the boot order process. These order changes are stored in the
physical ROM when the F10 Setup changes are confirmed with File>Save Changes and Exit.
You can temporarily override the boot order:
You can temporarily override the boot order. To boot one time from a device other than the default
device specified in Boot Order, restart the workstation and press F9 when the F9=Boot Menu
message appears on the screen. After POST completes, a list of bootable devices is displayed.
Use the arrow keys to select the preferred bootable device and press Enter. The workstation then
boots from the selected nondefault device for this one time.
To boot one time from a device other than the default device specified in Boot Order, restart the
workstation and press F9 when the F9=Boot Menu message appears on the screen. After POST
completes, a list of bootable devices is displayed. Use the arrow keys to select the preferred
bootable device and press Enter. The workstation then boots from the selected nondefault device
this time only.
Security

Setup Password

Enables you to set and enable setup (administrator) password.
NOTE: If the setup password is set, it is required to change computer setup options, flash the
ROM, and make changes to certain Plug and Play settings under Windows.

Power-On
Password

Enables you to set and enable the power-on password.

Password
Options

Lock Legacy Resources–Prevents the operating system from changing resources to Serial,
Parallel, and Diskette controller.
Setup Browse Mode–If a setup password is created, this mode enables read-only access to the
F10 Setup menu for users without a password.

ENWW

Smart Cover

Allows you to disable the cover removal sensor or to notify you if the sensor has been activated.

Device Security

Makes the following devices available or unavailable to the system:
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description
●

Serial port

●

Parallel port

●

Front USB port

●

Rear USB port

●

Internal USB port

●

System audio

●

Network controller

●

Legacy diskette

●

Embedded Security Device

●

SATA0–5

For each device, Device Available is the default setting and allows the operating system to access
the device. Device Hidden makes the device unavailable; it is disabled by the BIOS and cannot be
enabled by the operating system. When enabled, Embedded Security Device offers these options:
●

Embedded Security Device Support

●

Enable/Disable—Turns the Trusted Platform Mechanism (TPM) on and off. If this option is
enabled, the following options become available:
◦

Power-On Authentication Support—Enables and disables an authentication feature that
requires you to enter a TPM user key password to boot the system. This feature uses
the TPM to generate and store the authentication password.

◦

Reset Authentication Credential—Resets the authentication functionality and clears all
authentication credentials.

NOTE: A setup password must be set to enable the Embedded Security Device and to access
any security features associated with the Embedded Security Device.
Network Service
Boot

Enables or disables the ability to boot to the network using the F12 key or the boot order.

System IDs

Asset Tag—A 16–byte string identifying the system.
Ownership Tag—An 80–byte string identifying ownership of the system. This tag is displayed on
the screen during POST.
Universal Unique Identifier (UUID)—Can only be updated if the current chassis serial number is
invalid. (These ID numbers are normally set in the factory and are used to uniquely identify the
system.)
Keyboard—Enables you to set the keyboard locale for System ID entry.

DriveLock
Security

Allows you to select a hard drive, enable or disable DriveLock security on that drive, and set a
DriveLock password. This option appears only if your drive supports DriveLock.
CAUTION: Enabling DriveLock can render a hard drive permanently inaccessible if the master
password is lost or forgotten. No method exists to recover the password or access the data.

System Security

Data Execution Prevention—Enables or disables Data Execution Prevention mode in the
processors. This mode prohibits code from running in pages that were set up as data pages, and
prevents attacks such as buffer overflows. Operating system support is required for this feature.
Virtualization Technology (VTx)—Enables Intel Virtualization Technology to increase workstation
performance.
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description
Virtualization Technology Directed
OS Management of Embedded Security Device—Enables or disables the ability of the operating
system to control the TPM device, including turning it on and off, initializing it, and resetting it.
Reset of Embedded Security Device through OS—Enables or disables the ability of the operating
system to reset the TPM.

Power

Advanced**

ENWW

Setup Security
Level

Enables the administrator to selectively set the security level for each setup feature. The options
are: Setup Password and None. Browser mode must be enabled to use this option.

OS Power
Management

Enables or disables:
●

Runtime Power Management

●

ACPI S3 Hard Disk Reset

●

ACPI S3 PS 2 Mouse Wakeup

●

USB Wake on Device Insertion

●

Unique Sleep State Blink Rates

Hardware Power
Management

Enables or disables SATA Power Management

Thermal

Enables you set the rate of the system fan when the processor is in idle.

Power-On
Options

Allows you to set:
●

POST Mode (QuickBoot, FullBoot, or FullBoot every 1–30 days).

●

POST Messages (Enable or Disable).

●

F9 Prompt (Enable or Disable). Enabling this feature displays F9=Boot Menu during POST.
Disabling this feature prevents the text from being displayed. However, pressing the F9 key
still accesses the boot menu.

●

F10 Prompt (Enable or Disable)—Enabling this feature displays F10=Setup during POST.
Disabling this feature prevents the text from being displayed, but pressing F10 still accesses
the Setup screen.

●

F11 Prompt (Enable or Disable)—Makes the Factory Recovery option visible during POST.
Disabling this feature prevents the text from being displayed, but pressing F10 still accesses
the Setup screen. Factory Recovery Boot Support must be enabled to use this option.

●

F12 Prompt (Enable or Disable)—Enabling this feature displays F12=Network Service Boot
during POST. Disabling this feature prevents the text from being displayed but pressing F12
still forces the system to attempt booting from the network.

●

Factory Recovery Boot Support (Enable or Disable)—Recovery partition hard disk drive
(HDD) option available. Vista leaves the factory with this support in place.

●

Option ROM prompt* (Enable or Disable)—Enabling this feature causes the system to display
a message before loading options ROMs.

●

Remote Wakeup Boot Source

●

After Power Loss (On or Off)—Enabling this option directs the previous state to be the default.

●

POST Delay (in seconds) (Enable or Disable)—Enabling this feature adds a user-specified
delay to the POST process. This delay is sometimes needed for hard drives on some PCI
cards that spin up slowly (so slowly that they are not ready to boot by the time POST is

Computer Setup (F10) Utility
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description
finished). The POST delay also gives you more time to select F10 to enter the Computer
Setup (F10) Utility.
●

Limit (CPUID Maximum Value to 3) (Enable/Disable)

Execute
Memory Test

Tests workstation memory. The workstation reboots, and any changes that have been made are
lost. The workstation might boot with memory in a sub optimal configuration.

BIOS Power-On

Enables you to disable or specify a weekday and time for BIOS power-on.

Onboard
Devices

Enables you to set resources for or disable onboard system devices such as serial ports, parallel
ports, and diskette controllers. Operating system parameters generally override Onboard Devices
settings.

PCI Devices

Enables you to set the IRQ for or disable the following devices during POST:
●

Intel USB controllers

●

Intel HD audio device

●

Intel RAID controller

●

nVidia VGA controller

●

Broadcom Ethernet controller

Operating system parameters generally override PCI Devices settings.
Available IRQ values are 5, 10, and 11.
Bus Options

Device Options
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The options are:
●

PCI SERR# Generation (Enable/Disable)

●

PCI VGA Palette Snooping (Enable/Disable)

●

ECC Support (Enable/Disable)

●

Printer Mode (EPP + ECP, Output-Only, Bi-Directional)

●

Num Lock State at Power-On (On or Off)

●

S5 Wake-on-LAN (Enable or Disable)

●

Multi-Processor-Turns multi-core function to single-core

●

Internal Speaker (Enable or Disable)

●

Monitor Tracking (Enable or Disable)

●

NIC PxE Option ROM Download (Enable or Disable)

●

SATA RAID Option ROM Download (Enable or Disable)

Slot 1 (PCI
Express x 1)

Slot 1 option ROM download (Enable/Disable)

Slot 2 (PC
Express x16)

Slot 2 option ROM download (Enable/Disable) and latency timer.

Slot 3 (PCI
Express 4)

Slot 3 option ROM download (Enable/Disable).

Slot 4 (PCI
Express x16)

Slot 4 option ROM download (Enable/Disable).
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

Slot 5 (PCI)

Slot 5 option ROM download (Enable/Disable) and latency timer.

Slot 6 (PCI)

Slot 6 option ROM download (Enable/Disable) and latency timer.

Slot 7 (PCI)

Slot 7 option ROM download (Enable/Disable) and latency timer.

* Available on selected models.
**These options should be used by advanced users only.

Workstation management
The HP Client Management Solutions (CMS) which are available for download from http://www.hp.com/
go/easydeploy are standards-based solutions for managing and controlling workstations in a networked
environment. This section summarizes capabilities, features, and key components of workstation
management including:
●

Initial workstation configuration and deployment on page 35

●

Installing a remote system on page 36

●

Replicating the setup on page 36

●

Updating and managing software on page 37

●

ROM Flash on page 39

●

FailSafe Boot Block ROM on page 39

●

Asset tracking and security on page 40

●

Fault notification and recovery on page 49

●

Dual-state power button on page 49

NOTE:

Support for specific features described in this guide can vary by model and software version.

Initial workstation configuration and deployment
Your workstation includes a preinstalled system software image. After a brief software unbundling
process, the workstation is ready to use.
If you prefer to replace the preinstalled software image with a customized set of system and application
software, several methods are available for deploying a customized software image, including:
●

Installing additional software applications after unbundling the preinstalled software image

●

Using a disk cloning process to copy the contents from one hard drive to another

The best deployment method depends on your information technology environment and processes. The
PC Deployment section of the HP Lifecycle Solutions Web site (http://www.hp.com/support/HPLS)
provides information to help you select the best deployment method.
The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery
of system software, configuration management and troubleshooting, and power management.
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Installing a remote system
Remote system installation enables you to start and set up your system using the software and
configuration information located on a network server. This feature is usually used as a system setup
and configuration tool and can be used for the following tasks:
●

Deploying a software image on one or more new PCs

●

Formatting a hard drive

●

Installing application software or drivers

●

Updating the operating system, application software, or drivers

To initiate a remote system installation, press F12 when F12=Network Service Boot appears in the
lower right corner of the HP logo screen. Follow the onscreen instructions to continue the installation
process. The default boot order is a BIOS configuration setting that can be changed to always attempt
a PXE boot.

Replicating the setup
The following procedures enable you to copy one setup configuration to other workstations of the same
model for faster, more consistent configuration of multiple workstations. Both procedures require a
diskette drive or a USB device such as an HP Drive Key.

Copying a setup configuration to a single workstation
CAUTION: A setup configuration is model-specific. File system corruption can result if source and
target workstations are not the same model. For example, do not copy the setup configuration from an
HP xw4200 Workstation to an HP xw4600 Workstation.
1.

Select a setup configuration to copy, and then reboot the workstation.

2.

As soon as the workstation powers on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. If necessary, press Enter to bypass the title screen.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the utility.
If you are using a PS 2 keyboard, you may see a keyboard error message—disregard it.
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3.

If you are using a diskette or other storage device, insert it now. If not, proceed to the next step.

4.

Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette.

5.

Power off the workstation you are configuring and insert the configuration diskette into the diskette
drive.

6.

Power on the workstation you are configuring.

7.

Press and hold the F10 key until you enter the Computer Setup (F10) Utility. If necessary, press
Enter to bypass the title screen.

8.

Select File>Replicated Setup>Restore from Removable Media, and then follow the instructions
on the screen.

9.

Restart the workstation when the configuration is complete.
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Copying a setup configuration to multiple workstations
CAUTION: A setup configuration is model-specific. If source and target workstations are not the same
model, file system corruption can result . For example, do not copy the setup configuration from an HP
xw4200 Workstation to an HP xw4600 Workstation.
This method takes a little longer to prepare the configuration diskette, but copying the configuration to
target workstations is fast.
NOTE: A bootable diskette is required for this procedure. If Windows XP is not available to create a
bootable diskette, use the method for copying to a single workstation instead (see Copying a setup
configuration to a single workstation on page 36.)
1.

Create a bootable diskette.

2.

Select a setup configuration to copy.

3.

Restart the workstation.

4.

As soon as the workstation powers on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. If necessary, press Enter to bypass the title screen.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the utility.
If you are using a PS 2 keyboard, you might see a keyboard error message—disregard it.

5.

If you are using a diskette or other storage device, insert it now. If not, proceed to the next step.

6.

Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette.

7.

Download a BIOS utility for replicating setup (repset.exe) and copy it to the configuration diskette.
To obtain this utility, see http://www.hp.com/support/files. Enter the model number of the
workstation.

8.

On the configuration diskette, create an autoexec.bat file containing repset.exe and
cpqsetup.txt.

9.

Power off the workstation you are configuring. Insert the configuration diskette, and then power on
the workstation. The configuration utility runs automatically.

10. Restart the workstation when the configuration is complete.

Updating and managing software
HP provides several tools for managing and updating software on desktops and workstations: HP Client
Manager Software, Altiris Client Management Solutions, System Software Manager, Proactive Change
Notification, and Subscriber’s Choice.

HP Client Manager Software
HP Client Manager Software (HP CMS) assists customers in managing workstation hardware. It offers:
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●

Detailed views of hardware inventory for asset management

●

PC health-check monitoring and diagnostics

●

Proactive notification of changes in the hardware environment
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●

Web-accessible reporting of business-critical details such as thermal warnings, memory alerts, and
more

●

Remote updating of system software such as device drivers and ROM BIOS

●

Remote changing of boot order

●

Configuration of system BIOS settings

For more information about the HP Client Manager, see http://www.hp.com/go/ssm.

Altiris Client Management Solutions
Altiris and HP have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs. The HP Client Manager Software is the foundation
for additional Altiris Client Management Solutions that address:
●

Inventory and asset management

●

Deployment and migration

●

Help desk and problem resolution

●

Software and operations management

For more information about the following topics, go to http://www.hp.com/go/ssm:
●

How HP Client Manager Software works

●

Which solutions are compatible with your operating system

●

How to download a fully functional, 30-day evaluation version of Altiris solutions

System Software Manager
System Software Manager (SSM) is a utility that enables you to update system-level software on multiple
systems simultaneously. When executed on a PC client system, SSM detects both hardware and
software versions, and then updates the appropriate software from a central repository, also known as
a file store. Driver versions that are supported by SSM are denoted with a special icon on the software,
the driver download Web site, and on the Support Software CD. To download the utility or to obtain more
information about SSM, see http://www.hp.com/go/ssm.

Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice Web site to proactively and
automatically:
●

Send you Proactive Change Notification (PCN) emails informing you up to 60 days in advance
about hardware and software changes to most commercial workstations and servers

●

Send you e-mails containing customer bulletins, customer advisories, customer notes, and driver
alerts for most commercial workstations and servers

You can create your own profile to ensure that you only receive the information relevant to your specific
IT environment. To learn more about the PCN program and to create a custom profile, see Subscriber’s
Choice on page 39.
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Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP that supplies you with personalized product tips,
feature articles, and driver and support alerts and notifications based on your individual profile.
Subscriber’s Choice Driver and Support Alerts and Notifications delivers email notifying you that the
information you subscribed to in your profile is available for review and retrieval. To learn more about
Subscriber’s Choice and create a custom profile, see http://www.hp.com/subscriberschoice.

ROM Flash
Your HP workstation comes with a programmable flash ROM. By establishing a setup password in the
Computer Setup (F10) Utility, you can protect the ROM from being inadvertently updated or overwritten.
This function is important to ensure the operating integrity of the workstation. To upgrade the ROM,
download the latest SoftPaq images from http://www.hp.com//support/files.
NOTE: For maximum ROM protection, be sure to establish a setup password. The setup password
prevents unauthorized ROM upgrades. System Software Manager enables you to create the setup
password on one or more workstations simultaneously. For more information, see http://www.hp.com/
go/ssm.

Remote ROM Flash
Remote ROM Flash allows system administrators to safely upgrade the ROM on remote HP
workstations directly from a centralized network management console, resulting in a consistent
deployment of, and greater control over, HP PC ROM images over the network.
To use Remote ROM Flash, the workstation must be powered on, or turned on using Remote Wakeup.
For more information about Remote ROM Flash, see the HP Client Manager Software or System
Software Manager sections at http://www.hp.com/go/ssm.

HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on individual PCs through a
Windows operating system.
For more information about HPQFlash, visit http://www.hp.com/go/ssm, and enter the name of your
workstation.

FailSafe Boot Block ROM
The FailSafe Boot Block ROM enables system recovery in the unlikely event of a ROM flash failure. For
example, if a power failure occurs during a ROM upgrade, the Boot Block uses a flash-protected section
of the ROM to check for a valid system ROM flash when power to the system is restored.
●

If the system ROM is valid, the system starts normally.

●

If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support
to start the system from a BIOS image CD created from a SoftPaq. The BIOS image CD programs
the system ROM with a valid image.

When Boot Block detects an invalid system ROM, the workstation power LED blinks red eight times and
beeps eight times, then the workstation pauses for two seconds. Also, eight simultaneous beeps will be
heard. A Boot Block recovery mode message is displayed on the screen (some models).
In preparation for system recovery, use the BIOS CD media file in the SoftPaq to create a BIOS image
CD.
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To recover the system after it enters Boot Block recovery mode:
1.

If there is media in the diskette or optical drives, remove it.

2.

Insert a BIOS image CD into the CD drive. USB media (such as an HP DriveKey) can also be used.

3.

Power off, then power on the workstation.
If no BIOS image CD or USB is found, you are prompted to insert one and restart the workstation.
If a setup password has been established, the Caps Lock light illuminates and you are prompted
for the password.

4.

Enter the setup password.
If the system successfully starts from the CD or USB and successfully reprograms the ROM, then
the three keyboard lights illuminate. A rising-tone series of beeps also signals successful recovery.

5.

Remove the CD or USB media and power off the workstation.

6.

Restart the workstation.

The following table lists the various keyboard light combinations used by the Boot Block ROM (when a
PS 2 keyboard is attached to the workstation) and explains the meaning and action associated with
each combination.
Table 3-2 Keyboard light combinations used by Boot Block ROM
FailSafe Boot
Block mode

Keyboard LED activity*

State/Message

Num Lock

On

SoftPaq media is not present, is bad, or the drive not ready

Caps Lock

On

Enter password

Num, Caps,
Scroll Lock

Flash in sequence, one at
a time—N,C, SL

Keyboard locked in network mode

Num, Caps,
Scroll Lock

On

Boot Block ROM Flash successful. Reboot the system

*Diagnostic lights do not flash on USB keyboards.

Asset tracking and security
Asset tracking features incorporated into your workstation provide asset tracking data that can be
managed using HP Systems Insight Manager (SIM), HP Client Manager Software, or other systems
management applications. Seamless, automatic integration between asset tracking features and these
products enables you to choose the management tool that is best suited to your environment and to
leverage investments in existing tools.
HP also offers several solutions for controlling access to valuable components and information. HP
ProtectTools Embedded Security, if installed, prevents unauthorized access to data, checks system
integrity, and authenticates third-party users attempting system access. Security features such as
ProtectTools and the Hood Sensor (Smart Cover Sensor) help prevent unauthorized access to your
data and to the internal components of the workstation. By disabling parallel, serial, or USB ports, or by
disabling removable-media boot capability, you can protect valuable data assets. Memory Change and
Hood Sensor (Smart Cover Sensor) alerts can be automatically forwarded to system management
applications to deliver proactive notification of tampering with a workstation’s internal components.
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NOTE: ProtectTools, the Hood Sensor (Smart Cover Sensor), and the (Smart Cover Lock) are
available as options on select systems.
Use the following utilities to manage security settings on the HP workstation:
●

Locally, using the Computer Setup (F10) Utility

●

Remotely, using the HP Client Manager Software or System Software Manager which enables the
secure, consistent deployment and control of security settings from a simple command line utility

The following table and sections refer to the management of workstation security through the Computer
Setup (F10) Utility
Table 3-3 Security features overview
Feature

Purpose

How it is established

Removable Media Boot Control

Prevents booting from the removable media
drives

From the Computer Setup (F10)
Utility menu

Serial, Parallel, USB, or Infrared
Interface Control

Prevents transfer of data through the
integrated serial, parallel, USB, or infrared
interface

From the Computer Setup (F10)
Utility menu

Power-On Password

Prevents use of the workstation until the
password is entered (applies to both initial
system startup and restarts)

From the Computer Setup (F10)
Utility menu

Setup Password

Prevents reconfiguration of the workstation
(use of the Setup utility) until the password is
entered

From the Computer Setup (F10)
Utility menu

Network Server Mode

Provides unique security features for
workstations used as servers

From the Computer Setup (F10)
Utility menu

NOTE: For more information about the Computer Setup (F10) Utility, see Computer Setup (F10) Utility menu on page 29.

Password security
The power-on password prevents unauthorized use of the workstation by requiring entry of a password
to access applications or data each time the workstation is powered on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as
an override to the power-on password. When prompted for the power-on password, entering the setup
password instead enables access to the workstation.
You can establish a network-wide setup password to enable the system administrator to log in to all
network systems to perform maintenance without having to know the power-on password.
NOTE: System Software Manager and HP Client Manager Software enable remote management of
setup passwords and other BIOS settings in a networked environment. For more information, see
http://www.hp.com/go/easydeploy.
Establishing a setup password using the Computer Setup (F10) Utility
Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the
workstation (through the use of the Computer Setup (F10) Utility) until the password is entered.
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To establish a setup password using the Computer Setup (F10) menu:
1.

Power on or restart the workstation.

2.

As soon as the computer is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the utility.
If you are using a PS 2 keyboard, you might see a keyboard error message—disregard it.

3.

Select Security>Setup Password, and then follow the onscreen instructions.

4.

Before exiting, select File>Save Changes, and then select Exit.

Establishing a power-on password using workstation setup
Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the
workstation when power is connected, unless the password is entered. When a power-on password is
set, the Computer Setup (F10) Utility presents Password Options in the Security menu. The password
options include Network Server Mode and Password Prompt on Warm Boot.
When Network Server Mode is disabled, the password must be entered each time the workstation is
powered on when the key icon appears on the monitor. When Password Prompt on Warm Boot
is enabled, the password must also be entered each time the workstation is rebooted. When Network
Server Mode is enabled, the password prompt is not presented during POST, but any attached PS 2
keyboard remains locked until you enter the power-on password.
To enable Network Server Mode, a power-on password must be set. The option to set this password is
available under Advanced>Password Options. This option enables the system to boot without requiring
the power-on password, but the keyboard and mouse are locked until you enter the password. The
keyboard LEDs rotate constantly when the system is in locked mode.
To establish a power-on password through the Computer (F10) menu:
1.

Power on or restart the workstation.

2.

As soon as your workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the utility.
If you are using a PS 2 keyboard, you might see a keyboard error message—disregard it.

3.

Select Security>Power-On Password, and then follow the onscreen instructions.

4.

Before exiting, select File>Save Changes, and then Exit.

Entering a power-on password
1.

Restart the workstation.

2.

When the key icon appears on the monitor, enter the current password, and then press Enter.

NOTE:
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If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.
Entering a Setup Password
If a setup password has been established on the workstation, you will be prompted to enter it each time
you run the Computer Setup (F10) Utility.
To enter a setup password:
1.

Restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.
If you are using a PS 2 keyboard, you might see a keyboard error message—disregard it.

3.

When the key icon appears on the monitor, enter the setup password, and press Enter.

NOTE:

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.
Changing a power-on or setup password
1.

Restart the workstation.

2.

To change the power-on password, go to step 4.

3.

To change the setup password, as soon as the workstation is powered on, press and hold the
F10 key until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if
necessary.
NOTE: If you do not press F10 at the appropriate time, you must restart the workstation, and then
press and hold the F10 key again to access the utility.
If you are using a PS 2 keyboard, you might see a keyboard error message—disregard it.

4.

When the key icon appears, enter the current password, a slash (/) or alternative delimiter
character, your new password, another slash (/) or alternative delimiter character, and your new
password again as shown:
current password/new password/new password
See National keyboard delimiter characters on page 44 for information about the alternative
delimiter characters.
NOTE: Type carefully. For security reasons, the characters you enter do not appear on the
screen.

5.

Press Enter.

The new password takes effect the next time you power on the workstation.
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The power-on and setup passwords can also be changed using the Security options in the Computer
Setup (F10) Utility.

Deleting a power-on or setup password
1.

Power on or restart the workstation.

2.

To delete the power-on password, go to step 4.

3.

To delete the setup password, as soon as the workstation is powered on, press and hold the
F10 key until you enter the Computer Setup (F10) Utility. (Press Enter to bypass the title screen,
if necessary.)
NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer
and then press and hold the F10 key again to access the utility.
Use the appropriate operating system shutdown process.

4.

When the key icon appears, enter your current password followed by a slash (/) or alternative
delimiter character: current password/.
NOTE: See National keyboard delimiter characters on page 44 for information about the
alternative delimiter characters.

5.

Press Enter.

National keyboard delimiter characters
Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use
for changing or deleting passwords depend on the keyboard included with your workstation.
Table 3-4 National keyboard delimiter characters
Language

Delimiter

Language

Delimiter

Language

Delimiter

Arabic

/

Greek

-

Russian

/

Belgian

=

Hebrew

.

Slovakian

-

BHCSY*

-

Hungarian

-

Spanish

-

Brazilian

/

Italian

-

Swedish/Finnish

/

Chinese

/

Japanese

/

Swiss

-

Czech

-

Korean

/

Taiwanese

/

Danish

-

Latin American

-

Thai

/

French

!

Norwegian

-

Turkish

.

French
Canadian

é

Polish

-

U.K. English

/

German

-

Portuguese

-

U.S. English

/

NOTE: * Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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Clearing passwords
If you forget your password, you cannot access the workstation. See Resetting the password jumper
on page 149 for instructions about clearing passwords.
DriveLock
WARNING! Enabling DriveLock can render a hard drive permanently inaccessible if the master
password is lost or forgotten. No method exists to recover the password or access the data.
DriveLock uses an industry-standard security feature that prevents unauthorized access to the data on
an ATA hard drive. DriveLock has been implemented as an extension to Computer Setup (F10)
functions. It is only available when hard drives that support the ATA security command set are detected.
On HP workstations, it is not available when the SATA emulation mode is RAID+AHCI or RAID.
DriveLock is intended for HP customers for whom data security is a paramount concern. For such
customers, the cost of a hard drive and the loss of the data stored on it is inconsequential when compared
to the damage that could result from unauthorized access to its contents.
In order to balance this level of security with the practical need to address the issue of a forgotten
password, the HP implementation of DriveLock employs a two-password security scheme. One
password is intended to be set and used by a system administrator, while the other is typically set and
used by the end-user. There is no "back door" that can be used to unlock the drive if both passwords
are lost. Therefore, DriveLock is most safely used when the data contained on the hard drive is replicated
on a corporate information system or is regularly backed up. In the event that both DriveLock passwords
are lost, the hard drive is rendered unusable. For users who do not fit the previously defined customer
profile, this may be an unacceptable risk. For users who do fit this profile, it may be a tolerable risk,
given the nature of the data stored on the hard drive.
DriveLock applications
The most practical use of the DriveLock security feature is in a corporate environment. The system
administrator would be responsible for configuring the hard drive, which involves setting the DriveLock
master password and a temporary user password. In the event that the user forgets the user password
or the equipment is passed on to another employee, the master password can always be used to reset
the user password and regain access to the hard drive.
HP recommends that corporate system administrators who choose to enable DriveLock also establish
a corporate policy for setting and maintaining master passwords. This should be done to prevent a
situation where an employee intentionally or unintentionally sets both DriveLock passwords before
leaving the company. In such a scenario, the hard drive is rendered unusable and requires replacement.
Likewise, by not setting a master password, system administrators might find themselves locked out of
a hard drive and unable to perform routine checks for unauthorized software, other asset control
functions, and support.
For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users
in this category include personal users, or users who do not maintain sensitive data on their hard drives
as a common practice. For these users, the potential loss of a hard drive resulting from forgetting both
passwords is much greater than the value of the data DriveLock has been designed to protect.
Access to Computer Setup (F10) and DriveLock can be restricted through the setup password. By
specifying a setup password and not giving it to end users, system administrators are able to restrict
users from enabling DriveLock.
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Using DriveLock
When one or more hard drives that support the ATA security command set are detected, the DriveLock
option appears under the Security menu in Computer Setup (F10). You are presented with options to
set the master password and to enable DriveLock. A user password must be provided to enable
DriveLock. Since the initial configuration of DriveLock is typically performed by a system administrator,
a master password should be set first. HP encourages system administrators to set a master password
whether they plan to enable DriveLock or not. This gives the administrator the ability to modify DriveLock
settings if the drive is locked in the future. Once the master password is set, the system administrator
might enable DriveLock or choose to leave it disabled.
If a locked hard drive is present, POST requires a password to unlock the device. If a power-on password
is set and it matches the device’s user password, POST does not prompt the user to re-enter the
password. Otherwise, the user is prompted to enter a DriveLock password. For a cold-boot, use the
master or user password. For a warm-boot, you must enter the same password used to unlock the drive
during the preceding cold-boot. Users are given two attempts to enter a correct password. During coldboot, if neither attempt succeeds, POST continues but the drive remains inaccessible. During a warmboot or restart from Windows, if neither attempt succeeds, POST halts and the user is instructed to cycle
power.
To enable and set the DriveLock user password:
1.

Power on or restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the utility.
If you are using a PS2 keyboard, you might see a keyboard error message—disregard it.

3.

Select Security>DriveLock Security.

4.

For each DriveLock-capable drive, select a drive by pressing the F10 key to accept.

5.

Under Enable/Disable DriveLock options, select Enable, and then press the F10 key to enable
DriveLock for a particular drive.
CAUTION:

Forgetting the DriveLock password renders the drive unusable.

6.

Enter a new user password, and then press the F10 key to accept. This password may be 1 to 32
characters long.

7.

Enter the password again in the Enter New Password Again field. If you forget this password, the
drive is rendered permanently disabled.

8.

Select File>Save Changes and Exit, and then press the F10 key. After you press the F10 key,
the system performs a cold-boot before invoking the DriveLock function.

NOTE: This process can also be used to set the DriveLock master password by selecting Master in
Step 5.
When the workstation starts, you are prompted to enter the DriveLock password for each DriveLockcapable drive for which you have previously set a password. You are given two attempts to enter the
password correctly. If the password is not entered correctly, the workstation attempts to boot anyway.
However, the boot process most likely fails because data from a locked drive cannot be accessed.
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In a single drive workstation, if the drive has DriveLock enabled, the workstation might not be able to
boot to the operating system, and might try to boot from the network or from another storage device
instead (depending on the boot ordering options). Regardless of the outcome of the boot attempts, the
drive-locked drive remains inaccessible without the DriveLock password.
In a two-drive workstation that has a boot drive and a data drive, you can apply the DriveLock feature
to the data drive only. In this case, the workstation can always boot, but the data drive is accessible only
when the DriveLock password is entered.
Cold-boots require that you enter DriveLock passwords. However, DriveLock passwords are also
required for warm-boots. For example, if you boot to DOS and enter Ctrl-Alt-Del, you must enter the
DriveLock password before the workstation completes the next boot cycle. This warm-boot behavior is
consistent with the DriveLock feature.

Hood Sensor (Smart Cover Sensor) (optional)
The optional Hood Sensor is a combination of hardware and software technology that can alert you
when the workstation side access panel has been removed (if the sensor has been properly configured
in the Computer Setup (F10) Utility). There are three levels of Hood Sensor protection:
Table 3-5 Hood Sensor protection levels
Level

Setting

Description

Level 0

Disabled

Hood Sensor is disabled (default).

Level 1

Notify User

When the workstation restarts, a message is displayed indicating that the
workstation side access panel has been removed.

Level 2

Setup Password

When the workstation is restarted, a message is displayed indicating that the
workstation side access panel has been removed. You must enter the setup
password to continue.

Hood Sensor settings can be changed using the Computer Setup (F10) Utility.

Setting the Hood Sensor protection level
1.

Power on or restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer,
and then press and hold the F10 key again to access the Computer Setup (F10) Utility.
If you are using a PS 2 keyboard, you might see a keyboard error message—disregard it.

3.

Select Security>Smart Cover>Cover Removal Sensor, and follow the onscreen instructions.

4.

Before exiting, select File>Save Changes, and then select Exit.

Hood Lock (Smart Cover Lock) (optional)
The is an optional solenoid that secures the workstation access cover to the chassis. It is controlled by
a BIOS password. When installed, the Hood Lock can prevent unauthorized access to the internal
workstation components.
CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup
password prevents unauthorized access to the Computer Setup utility.
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Locking the Hood Lock
1.

Power on or restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.
If you are using a PS2 keyboard, you might see a keyboard error message—disregard it.

3.

Select Security>Smart Cover>Cover Lock>Lock.

4.

Select Fire>Save Changes and Exit.

Unlocking the Hood Lock
1.

Turn on or restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.
If you are using a PS2 keyboard, you might see a keyboard error message—disregard it.

3.

Select Security>Smart Cover>Cover Lock>Unlock.

4.

Select File>Save Changes and Exit.

Using the FailSafe key
If you enable the Hood Lock and cannot enter your password to disable it, you must have a FailSafe
key to open the workstation side access panel. The FailSafe key is required in any of the following
circumstances:
●

Power outage

●

Startup failure

●

PC component failure (such as a processor or power supply)

●

Forgotten password

CAUTION: The side access panel FailSafe key is a specialized tool available from HP. Be sure to
order the key from HP in advance so it is available when you need it.
To obtain the FailSafe Key, contact HP post sales support by telephone at: 1-800–hp-invent, or by
visiting http://welcome.hp.com/country/us/en/wwcontact_us.html.

Cable lock (optional)
To prevent theft, the rear chassis panel of your workstation accommodates a keyed cable lock. This
cable lock attaches to the chassis and secures it to the work area.
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Security lock (Padlock loop) (optional)
The rear chassis panel of your workstation provides a padlock loop. A padlock can be attached in this
loop to prevent workstation access panel removal.

Universal chassis clamp lock (optional)
The universal chassis clamp lock secures the access panel to the chassis using a screw-type
attachment. A built in key lock prevents access to the securing screw. In addition, cables can be added
to the universal chassis clamp lock to secure workstation peripherals, and to secure the workstation to
the work area.

Fault notification and recovery
Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.
If the workstation is connected to a network that is managed by HP Client Manager Software, the
computer sends a fault notice to the network management application. With HP Client Manager
Software, you can also remotely schedule diagnostics to automatically run on all managed PCs and
create a summary report of failed tests.

Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives that is installed in select
HP workstations. The DPS is designed to help diagnose problems that might result in unwarranted hard
drive replacement.
When HP workstations are built, each installed hard drive is tested using the DPS, and a permanent
record of key information is written onto each drive. Every time the DPS is run, test results are written
to the hard drive. The service provider can use this information to help diagnose conditions that required
you to run the DPS software.

ECC fault prediction
When the workstation encounters an excessive number of error checking and correcting (ECC) memory
errors, it displays a local alert message. This message contains detailed information about the errant
memory module, enabling you to take action before you experience noncorrectable memory errors. ECC
memory modules are standard on the HP xw4600 Workstation.

Thermal sensors
There are several thermal sensors in your HP xw4600 Workstation that regulate the workstation fans
to maintain an acceptable, efficient chassis temperature.

Dual-state power button
With ACPI enabled, the power button can function either as an on/off switch or as a button. This feature
does not completely turn off power, but instead causes the workstation to enter a low-power standby
state. This allows you to power of the wowrkstation without closing applications, and to return to the
same operational state without any data loss.
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To change the power button configuration:
1.

Select Start, and then select Control Panel>Power Options.

2.

In Power Options Properties, select the Advanced tab.

3.

In the Power Button section, select Hibernate. (Hibernate must be enabled in the Hibernate
tab.)

After configuring the power button to function as a button, press the power button to put the system in
a very low power state. Press the button again to bring the system out of this very low power state to
full power state. To completely turn off all power to the system, press and hold the power button for four
seconds.
CAUTION: Do not use the power button to power off the workstation unless the system is not
responding; turning off the power without operating system interaction could cause damage to or loss
of data on the hard drive.
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4

Removal and replacement procedures

This chapter describes the removal and replacement procedures for most internal workstation
components including the following topics:

ENWW

●

Warnings and cautions on page 52

●

Service considerations on page 53

●

Customer Self-Repair on page 58

●

Predisassembly procedures on page 58

●

System board components on page 59

●

Removing and replacing components on page 60

●

Product recycling on page 108
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Warnings and cautions
Observe the following warnings and cautions when performing the removal and replacement
procedures.
WARNING!
Any product shipped in packaging marked with this symbol indicates the product must
always be lifted by two persons to avoid personal injury due to product weight.
WARNING!
Any surface or area of the equipment marked with this symbol indicates the presence
of a hot surface or hot component. If this surface is contacted, the potential for injury exists. To reduce
the risk of injury from a hot component, enable the surface to cool before touching.
WARNING!
Any surface or area of the equipment marked with this symbol indicates the presence
of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open any enclosed
area marked with this symbol.
WARNING! To reduce the risk of electric shock or damage to your equipment:
— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.
— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.
— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.
WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper
workstation setup, posture, health, and work habits for computer users, and provides important electrical
and mechanical safety information. This guide is located at http://www.hp.com/ergo and on the
documentation CD (if one is included with the product).
CAUTION: Static electricity can damage the electronic components of the workstation. Before
beginning these procedures, be sure you discharge static electricity by briefly touching a grounded metal
object.
CAUTION: Observe the following cautions when removing or replacing a processor:
— Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller
or service provider to install the processor. If you plan to install the processor yourself, read all of the
instructions carefully before you begin.
— Failure to follow the workstation preparation instructions can result in an improperly installed
processor, causing extensive workstation damage.
— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor
in the socket.
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CAUTION: To prevent damage to the workstation, observe the following Electrostatic Discharge
(ESD) precautions while performing the system parts removal and replacement procedures:
— Work on a static-free mat.
— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body
to the ground.
— Create a common ground for the equipment you are working on by connecting the static-free mat,
static strap, and peripheral units to that piece of equipment.
NOTE: HP accessories are for use in HP Workstation products. They have been extensively tested
for reliability and are manufactured to high quality standards.

Service considerations
The following sections describe service considerations that should be reviewed and practiced before
removing and replacing any system components.
WARNING! When lifting or moving the workstation, do not use the front bezel as a handle or lifting
point. Lifting the workstation from the front bezel, or lifting it incorrectly, can cause the workstation to fall,
possibly harming you and damaging the workstation. To properly and safely lift the workstation, lift it
from the bottom.

Cautions, warnings, and safety precautions
For your safety, review Warnings and cautions on page 52 before accessing the workstation
components. Also, review the Safety and Regulatory Guide that came with your workstation for more
information.

ESD information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often, the discharge is neither felt nor heard, but damage occurs nonetheless.
An electronic device exposed to electrostatic discharge (ESD) might not appear to be affected at all and
can function normally for a while, but it has been degraded in the internal layers, reducing its life
expectancy.
Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating static
The following table shows that different activities generate different amounts of static electricity. Static
electricity increases as humidity decreases.
Table 4-1 Static electricity
Relative humidity
Event
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40%

10%

Walking across carpet

7,500V

15,000V

35,000V

Walking across vinyl floor

3,000V

5,000V

12,000V

Service considerations

53

Table 4-1 Static electricity (continued)
Relative humidity
Motions of bench worker

400V

800V

6,000V

Removing bubble pack from PCB

7,000V

20,000V

26,500V

Packing PCBs in foam-lined box

5,000V

11,000V

21,000V

CAUTION: 700 volts can degrade a product.

Preventing ESD equipment damage
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories:
●

Transport products in static-safe containers such as tubes, bags, or boxes, to avoid hand contact.

●

Protect all electrostatic parts and assemblies with nonconductive or approved containers or
packaging.

●

Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

●

Place items on a grounded surface before removing them from their containers.

●

When handling or touching a sensitive component or assembly, ground yourself by touching the
chassis.

●

Avoid contact with pins, leads, or circuitry.

●

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Personal grounding methods and equipment
Use the following items to help prevent ESD damage to equipment:
●

Wrist straps—flexible straps with a maximum of one megohm ± 10% resistance in the ground
cords. To provide a proper ground, wear the strap against bare skin. The ground cord must be
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

●

Heel straps, toe straps, and boot straps—can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one megohm ± 10% resistance between the operator and
ground.

Table 4-2 Static shielding protection levels
Method
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Voltage

Antistatic plastic

1,500V

Carbon-loaded plastic

7,500V

Metallized laminate

15,000V
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Grounding the work area
To prevent static damage in your work area:
●

Cover the work surface with approved static-dissipative material. Use a wrist strap connected to
the work surface, and properly grounded tools and equipment.

●

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

●

Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only in static-free work areas.

●

Disconnect power and input signals before inserting and removing connectors or test equipment.

●

Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

●

Keep work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Use field service tools that are conductive, such as cutters, screwdrivers, and vacuums.

Recommended ESD prevention materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:
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●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Conductive foam

●

Conductive tabletop workstations with a ground cord of one megohm ± 10% resistance

●

Static-dissipative table or floor mats with a hard-tie to ground

●

Field service kits

●

Static awareness labels

●

Wrist straps and footwear straps providing one megohm ± 10% resistance

●

Material-handling packages

●

Conductive plastic bags

●

Conductive plastic tubes

●

Conductive tote boxes

●

Opaque shielding bags

●

Transparent metallized shielding bags

●

Transparent shielding tubes
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Tools and software requirements
●

Torx T-15 driver

●

Flat blade and cross-tip screwdrivers

●

Diagnostics software

Screws
The screws used in the workstation are not interchangeable. Metric screws are used for optical and
diskette devices, and American National Standards Institute (ANSI) screws are used for hard drives. If
an incorrect screw is used during the reassembly process, it can damage the workstation. HP strongly
recommends that you keep all screws removed during disassembly with the removed part, and then
returned to their proper locations.
NOTE:

Metric screws have a black finish. ANSI (unified) screws have a silver finish.

As each subassembly is removed from the workstation, place the subassembly away from the work
area to prevent damage.
Additional drive-guide screws are provided on the system chassis in case they are needed. The
Figure 4-1 Metric and ANSI screw identification on page 56 figure shows the eight metric M3 screws
(1) located on the chassis near the 5.25-inch optical drive bays. These screws can be used to mount
additional optical drives or an optional diskette drive. There are four ANSI 6–32 screws (2) located on
the chassis near the hard drive. These screws can be used to mount additional hard drives in the 3.5
inch hard drive cage.
NOTE:

The metric (black) and ANSI (silver) screws are not interchangeable.

Figure 4-1 Metric and ANSI screw identification
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Table 4-3 Screw ID
Item

Description
Metric screws (M3)

1
2

ANSI screws (6–32)

Special handling of components
The components included in this section require special handling when servicing the workstation.
WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the workstation.
Lifting the workstation from the front bezel, or lifting it incorrectly, could cause the workstation to fall,
causing possible injury to you, and damage to the workstation. To properly and safely lift the workstation,
lift from the bottom of the workstation for either the desktop or minitower configuration.

Cables and connectors
Cables must be handled with care to avoid damage. Apply only the tension required to seat or unseat
cables during insertion or removal from the connector. Handle cables by the connector or pull-strap
whenever possible. In all cases, avoid bending or twisting the cables, and be sure that the cables are
routed in such a way that they cannot be caught or snagged by parts being removed or replaced.
CAUTION: When servicing this workstation, be sure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the workstation.

Hard drives
Hard drives are fragile, precision components. Therefore, you must avoid subjecting them to physical
shock and vibration. This guideline applies to failed drives and replacement drives and spares.
●

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the workstation.

●

Avoid dropping hard drives from any height.

●

If you are inserting or removing a hard drive, power off the workstation. Do not remove a hard drive
while the workstation is powered on or in standby mode.

●

Before handling a drive, be sure that you discharge static electricity. While handling a drive, avoid
touching the connector. For more information about preventing electrostatic damage, see ESD
information on page 53.
CAUTION: To prevent possible ESD damage when the drive is installed, always connect the
drive power cable before connecting the data cable. This discharges accumulated static electricity
through the drive power cable to the workstation chassis.
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●

Do not use excessive force when inserting a drive.

●

Avoid exposing a hard drive to liquids, temperature extremes, or products with magnetic fields such
as monitors or speakers.
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Lithium coin cell battery
The battery included with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.
For instructions on battery removal and replacement, see Battery on page 87.
WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short the external contacts, dispose
of in water or fire, or expose the battery to temperatures higher than 60° Centigrade (140° Fahrenheit).
NOTE:
waste.

Batteries, battery packs, and accumulators should not be disposed of with general household

Customer Self-Repair
Customer Self-Repair enables you to obtain replacement parts and install them yourself on the
workstation. For more information, see: http://www.hp.com/go/selfrepair/.

Predisassembly procedures
Perform the following steps before servicing the workstation:
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1.

Close all open software applications.

2.

Remove all diskettes, CDs, and DVDs from the workstation.

3.

Shut down the operating system.

4.

Power off the workstation and all peripheral devices connected to it.

5.

Remove or disengage all security devices that prevent you from opening the workstation.

6.

Disconnect the power cord from the electrical outlet and then from the workstation.

7.

Disconnect all peripheral device cables from the workstation.
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System board components
The following figure shows the system board connectors and sockets on the HP xw4600 Workstation.
Figure 4-2 System board component identification

Table 4-4 System board components
No.

Component

No.

Component

No.

Component

1

Keyboard/mouse

13

Clear CMOS button

25

PCI Express x8 (4)*

2

Rear chassis fan

14

Front chassis fan

26

PCI Express x16

3

Processor power

15

Front control panel

27

PCI Express x1

4

Processor

16

Battery

28

2nd serial adapter port

5

Solenoid hood lock

17

Front USB

29

eSATA

6

Processor fan

18

USB

30

USB

7

Memory module sockets

19

Internal USB

31

Network/USB

8

Diskette drive

20

Speaker

32

Audio

9

Main power

21

Front audio

33

USB

10

Chassis intrusion switch

22

Auxiliary audio

34

Parallel

11

Password jumper

23

PCI 32/33

35

Serial

12

SATA

24

PCI Express x16

* Electrically x4 bandwidth
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Removing and replacing components
This section provides procedures to remove and install hardware components on your workstation.
Before servicing your workstation, review the safety information and precautions in the Service
considerations on page 53, and the Safety and Regulatory Information for your workstation.
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1.

Read all safety information and precautions.

2.

Locate and clear a suitable work area.

3.

Power down the workstation and disconnect power from the workstation.

4.

Gather your tools.

5.

Service the workstation.

6.

Restore power to the workstation.
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Disassembly order
Use the following table to determine the sequence in which to remove major workstation components.
Table 4-5 Workstation component disassembly order

Predisassembly (Predisassembly procedures
on page 58)
Security lock (Security lock (Padlock loop)
(optional) on page 62
Side access panel (Side access panel
on page 64)
Hood Sensor (Hood Sensor (Smart Cover Sensor)
(optional) on page 65)
Smart Cover Lock solenoid (Smart Cover Lock solenoid
(optional) on page 66)
Front bezel (Front bezel
on page 67)
Bezel blanks (Bezel blanks on page 68)
Front panel I/O device assembly (Front panel I/O device
assembly on page 69)
Power button assembly (Power button
assembly on page 71)
Optical drives (Optical drive (minitower configuration)
on page 90, Optical drive (desktop configuration)
on page 92
Diskette drive (Diskette drive (optional)
on page 95)
System speaker (System speaker
on page 72)
Power supply (Power supply
on page 73)
System fan (System fan assembly
on page 74)
PCI card guide and front fan (optional) (Front PCI card
guide and fan removal (optional) on page 86)
Memory (Memory on page 75)
PCI retainer (PCI card
support bracket
on page 80)
PCI slots (PCI card slots
on page 79)
PCI Express card (PCI Express cards
on page 81)
PCI card (PCI card
on page 83)
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Table 4-5 Workstation component disassembly order (continued)
Hard drives (SAS hard drive
on page 96), SATA hard drive
on page 99)
Processor heatsink (Processor heatsink
on page 103)
Processor (System
processor on page 105)
System board (System board
on page 107)
Battery (Battery
on page 87)

Security lock (Padlock loop) (optional)
If a security padlock is installed on your workstation, remove it before servicing the workstation.

Removing the security lock
To remove the padlock, unlock it and slide it out of the padlock loop as shown in the following figure.
Figure 4-3 Removing the security lock

Cable lock (optional)
If a cable lock is installed on your workstation, remove it before servicing the workstation.
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Removing the cable lock
To remove the cable lock, unlock it and pull it out of the cable lock slot as shown in the following figure.
Figure 4-4 Removing the cable lock

Universal chassis clamp lock (optional)
If a universal chassis clamp lock is installed on your workstation, remove it before servicing the
workstation.

Removing the chassis clamp lock
To remove the lock:
1.

Unlock the device and remove the locking mechanism.
Figure 4-5 Unlocking the device
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2.

Remove the screw attaching the lock to the chassis.
Figure 4-6 Removing the lock screws

Side access panel
Before accessing the internal components of the workstation, the side access panel must be removed.
This section describes how to remove and replace the side access panel.

Removing the side access panel
To remove the side access panel:
WARNING! Before removing the workstation side access panel, be sure that the workstation is
powered off and that the power cord is disconnected from the electrical outlet.
1.

Disconnect power from the system
(Predisassembly procedures on page 58).

2.
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Unlock any locks that may be present (cable lock or padlock).
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3.

Pull open the access panel handle (1).
Figure 4-7 Removing the access panel

4.

Slide the access panel toward the rear of the workstation and lift off the cover (2).

Replacing the side access panel
To replace the side access panel:
1.

Place the access panel over the chassis and align the tabs along the edges of the access panel
with the slots in the chassis.

2.

Press the access panel down, fitting the tabs into the slots.

3.

Slide the access panel toward the front of the chassis until it locks into place.
Figure 4-8 Installing the access panel

Hood Sensor (Smart Cover Sensor) (optional)
This section describes how to remove the Hood Sensor.
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Removing the Hood Sensor
To remove the Hood Sensor:
1.

Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).

2.

Disconnect the Hood Sensor connector from system board (1).
Figure 4-9 Removing the Hood Sensor

3.

Slide the Hood Sensor forward, push it down, and then remove it from the chassis (2).

NOTE:

To replace the Hood Sensor, reverse the previous steps.

Smart Cover Lock solenoid (optional)
This section describes how to remove the Smart Cover Lock solenoid

Removing the Smart Cover Lock solenoid
To remove the Smart Cover Lock solenoid:
NOTE: To purchase a FailSafe key, contact your authorized HP reseller or service provider, or visit
the HP Web site for ordering information.
1.
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Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).
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2.

Disconnect the solenoid cable from the system board (1).
Figure 4-10 Removing the Smart Cover Lock solenoid assembly

3.

Using the FailSafe key (T-15 wrench), unscrew the two screws from the back of the chassis (2).

4.

Slide the solenoid assembly away from the chassis and out of the workstation (3).

NOTE:

To install the Smart Cover Lock solenoid assembly, reverse the previous steps.

Front bezel
This section describes how to remove and replace the front bezel.
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Removing the front bezel
To remove the front bezel:
1.

Lift the two release snaps located on the front bezel (1).
Figure 4-11 Removing the front bezel

2.

Rotate the front bezel away from the chassis to remove the bezel (2).

Replacing the front bezel
To replace the front bezel, align front bezel on the bottom and rotate in until it snaps into place.

Bezel blanks
This section describes how to remove bezel blanks

Removing bezel blanks
To remove bezel blanks:
1.

68

Disconnect power from the system (Predisassembly procedures on page 58) and remove the front
bezel (Removing the front bezel on page 68).
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2.

Gently push the subpanel out the back of the front bezel (1).
Figure 4-12 Removing the bezel blanks

3.

Remove the desired bezel blank by applying outward pressure on the subpanel (1) and pulling the
blank away (2).

NOTE: The bezel blanks are keyed to assist you in replacing them. Also, the subpanel can be rotated
90 degrees to install optical drives in a desktop orientation.

Front panel I/O device assembly
This section describes how to remove and install a front panel I/O device assembly.

Removing the front panel I/O device assembly
To remove the front panel I/O device assembly:
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the front bezel
(Removing the front bezel on page 68).
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2.

If necessary, unlatch the plastic snap that secures the cables inside the chassis (1), and then
disconnect the front panel I/O device assembly cables from the system board (2).
Figure 4-13 Removing front panel I/O device cables

3.

Remove the two smaller Torx screws (1) that hold the front panel I/O device assembly and bracket
to the chassis (3).
Figure 4-14 Removing the front panel I/O device assembly
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4.

Remove the two larger Torx screws (2) that hold the front panel I/O device assembly to the bracket
(3).

5.

Separate the bracket from the front panel I/O device assembly.

6.

Pull the front panel I/O device assembly out about two inches from the chassis (5).

7.

Pull the front panel cables through the chassis and through the front of the workstation. You might
have to slide the cables out one at a time.
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Installing the front panel I/O device assembly
To instal the front panel I/O device assembly:
1.

Thread each front panel I/O device assembly cable through the same holes from which they were
removed.

2.

Push the front panel I/O device assembly into the chassis. Using your fingers, orient the cables so
that there is enough room for the front panel I/O device assembly to easily fit in its slot.

3.

Loosely place the bracket on the front panel I/O device assembly and hook the bracket to the
chassis.

4.

Screw the bracket to the front panel I/O device assembly, and then screw the bracket to the chassis.

5.

Connect the front audio cable to the audio connector (1). Connect the front USB cable to the USB
connector (2). Connect the front control panel cable to the control panel connector (3). If an
IEEE-1394 card is installed, connect the front IEEE-1394 cable to the card connector.

Figure 4-15 Attaching the front panel I/O device assembly cables

Power button assembly
This section describes how to remove the power button assembly.

Removing the power button assembly
To remove the power button assembly:
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), remove the front bezel (Removing
the front bezel on page 68), and then remove the front panel I/O device assembly (Removing the
front panel I/O device assembly on page 69).
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2.

Disconnect the power button assembly cable from the system board.
Figure 4-16 Removing the power button assembly cable

3.

Press in on the clips that secure the power button assembly to the chassis (1).
Figure 4-17 Removing the power button assembly

4.

Dislodge the metal clip from the chassis by rocking the power button assembly back and forth, and
then slide the power button assembly out from the front of the chassis (2).

NOTE:

To replace the power button assembly, reverse the previous steps.

System speaker
This section describes how to remove the system speaker.
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Removing the system speaker
To remove the system speaker:
1.

Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).

2.

Disconnect the speaker cable from the system board (1).
Figure 4-18 Removing a system speaker

3.

Remove the four screws (2) securing the speaker to the chassis and remove the speaker from the
chassis (3).

NOTE:

To replace the speaker, reverse the previous steps.

Power supply
This section describes how to remove the power supply.

Removing the power supply
To remove the power supply:
1.

Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).
TIP: The next step requires disconnecting several power cables. To ease the installation of the
power supply, it is helpful to write down the numbers on the cables so you can easily reconnect
the cables to the correct devices.

2.
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Disconnect all cables from the system board, drives, and cards.
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3.

Remove the four screws from the back panel (1).
Figure 4-19 Removing the power supply

4.

Slide the power supply toward the front of the chassis and lift it out of the chassis (2).

NOTE:

To replace the power supply, reverse the previous steps.

System fan assembly
This section describes how to remove the system fan assembly.

Removing the system fan assembly
To remove the system fan assembly:
1.
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Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).
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2.

Disconnect the fan plug from the system board (1).
Figure 4-20 Removing the system fan

3.

Use a cross-tip screwdriver to remove the four screws from the rear of the chassis (2).

4.

Lift the system fan out of the chassis (3).

CAUTION: When replacing the system fan, be sure that the fan is seated with the airflow direction
arrow pointing toward the rear of the chassis.
NOTE:

To install the system fan assembly, reverse these steps.

Memory
This section describes how to remove and install a memory module.

Removing a memory module
1.

Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).
CAUTION: To ensure that memory modules are not damaged during removal or installation,
power off the workstation and unplug the power cord from the AC power outlet. If you do not unplug
the power cord before installing memory, the modules might be damaged and the system will not
recognize the memory changes.
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2.

Push gently outward on the socket levers (1).
Figure 4-21 Removing a memory module

3.

Lift the DIMM straight up and out of the socket. Store the DIMM in an anti static bag (2).

Installing a memory module
This section describes how to install a memory module.
Supported DIMM configurations
The HP xw4600 Workstation supports these memory module configurations:
●

Four DIMM slots

●

Memory configuration from 512 MB to 2 GB

●

Dual-channel DIMMs

Memory module requirements
CAUTION: HP only ships DIMMs that are electrically and thermally compatible with this workstation.
Because third-party DIMMs might not be electrically or thermally compatible, they are not supported by
HP.
NOTE: DIMMs and their sockets are keyed for proper installation. Be sure these guides line up when
installing DIMMs.
Use only industry-standard, unbuffered, PC2–5300E (667 MHz) or PC2–6400E (800 MHz) DIMMs.
If multiple DIMMs are installed in a workstation, they must be installed in pairs of the same size and type
in each channel.
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Required DIMM installation order
Use the following illustration as a guide for installing memory:
●

If installing only one DIMM, it must be installed in socket (1).

●

The first DIMM pair must be installed in sockets (1) and (3).

●

The second DIMM pair must be installed in sockets (2) and (4).

Figure 4-22 Required DIMM installation order

Installing a memory module
To install a memory module:
1.
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Disconnect power from the system (Predisassembly procedures on page 58), and then remove
the side access panel (Removing the side access panel on page 64).
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2.

Push gently outward on the socket levers.
Figure 4-23 Opening the DIMM socket levers

3.

Align the DIMM connector key with the DIMM socket key, and then seat the DIMM firmly in the
socket (1).

4.

Secure the socket levers (2).
Figure 4-24 Installing a memory module
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PCI card slots
The following figure illustrates the xw4600 Workstation PCI card slots.
Figure 4-25 Identifying PCI card slots

Table 4-6 PCI slots
Slot

Type

Slot power (Maximum)

1

PC-Express x1

25W

2

PCI-Express x16*

75W

3

PCI-Express x8 (x4)

25W

4

PCI-Express x16*

75W

5

PCI 32/33

25W

6

PCI 32/33

25W

7

PCI 32/33

25W

* The maximum graphics configuration can be: two 75W cards
(one in slot two; one in slot four), or one 150W card, preferably in
slot 2. If a 150W card is used, HP suggests that the adjacent slot
remain empty.
in either slot 2 or slot 4. If a 150W card is used, the adjacent slot
must remain empty.
in either slot 2 or slot 4. If a 150W card is used, the adjacent slot
must remain empty.
Graphics cards greater than 75W require the use of a graphics
cable adapter.

NOTE: In addition to these slot power specifications, the overall power consumption of the system
(including I/O cards, processor, and memory) must not exceed the maximum rating of the system power
supply.
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PCI card support bracket
Some PCI cards have retainers installed to prevent movement during shipping.

Removing a PCI card support bracket
To remove a PCI card support bracket:
1.

Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64)

2.

Remove the two screws that attach the bracket to the chassis (1).
Figure 4-26 Removing a PCI card support bracket

3.

Lift the bracket out of the chassis (2).

Installing a PCI card support bracket
To install the PCI card support bracket:
1.
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Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).
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2.

Align the rear bracket with the holes in the rear of the chassis (1), and then rotate the bracket down
into position (2).
Figure 4-27 Installing a PCI card support bracket

3.

Secure the bracket to the chassis with two screws (3).

PCI Express cards
PCI Express improves system attributes and enables a low-power, scalable, high-bandwidth
communication path using a small number of connections, or wires, compared to traditional parallel
interfaces such as PCI. The PCI Express I/O slots can support other PCI Express cards with less bus
bandwidth than what is physically defined for the slot. Use the following table to determine PCI Express
card compatibility.
Table 4-7 PCI Express compatibility matrix for the HP xw4600 Workstation
Slot type

Mechanical compatibility

Electrical compatibility

PCI Express x1 slot

x1 cards

x1 modes

PCI Express x8 (x4) slot

x1, x4, and x8

x1 and x4 modes

PCI Express x16 slot

x1, x4, x8 and x16 cards

x1, x4, x8, and x16 modes

Removing a PCI Express card
To remove a PCI Express card:
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the PCI retainer, if
installed (PCI card support bracket on page 80).
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2.

Open the PCI card retention clamp. Press the retention clamp levers down to unsnap, and then
rotate them up (1).
Figure 4-28 Removing a PCI Express card

3.

If removing a PCI Express x16 graphics card, press in on the release lever (2) while lifting the card
(3) out of the chassis. Store the card in an anti-static bag.
If removing s PCI Express card without a release lever, simply lift the card out of the chassis.

4.

Install a PCI slot cover and close the PCI retention clamp. If the PCI retention clamp levers do not
close, ensure that all cards are properly seated, and then try again.

Installing a PCI Express card
To install a PCI Express card:
1.

82

Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and remove the PCI retainer (PCI
card support bracket on page 80), if installed.
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2.

Open the PCI card retention clamp. Press the retention clamp levers down to unsnap, and then
rotate them up (1).
Figure 4-29 Installing a PCI Express card

3.

Remove the PCI slot cover (2).

4.

Align the keyed components of the PCI card with the slot , and then firmly seat the card in the slot
(3).

5.

Close the PCI card retention clamp by rotating the clamp downward and pressing the two green
clamp levers from the rear panel of the chassis (4).

PCI card
This section describes removing and installing PCI cards.

Removing a PCI card
To remove a PCI card:
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the PCI card support
bracket, if installed (PCI card support bracket on page 80).
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2.

Open the PCI card retention clamp. Press the retention clamp levers down to unsnap, and then
rotate them up (1).
Figure 4-30 Removing a PCI card

3.

Lift the PCI card out of the chassis (2). Store the card in an anti static bag.

4.

Install a PCI slot cover and close the PCI retention clamp. If the PCI retention clamp levers do not
close, ensure that all cards are properly seated, and then try again.

Installing a PCI card
To install a PCI card:
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the PCI card support
bracket, if installed (PCI card support bracket on page 80).
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2.

Open the PCI card retention clamp. Press the retention clamp levers down to unsnap, and then
rotate them up (1).
Figure 4-31 Installing a PCI card

3.

Remove the PCI slot cover (2).

4.

Align the keyed components of the PCI card with the slot , and then firmly seat the card in the slot
(3).

5.

Close the PCI retention clamp by rotating the clamp downward and pressing the two green clamp
levers from the rear panel of the chassis (4).

IEEE-1394 card (optional)
This section describes how to remove an IEEE-1394 card.

Removing an IEEE-1394 card
To remove an IEEE-1394 card:
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the front bezel
(Removing the front bezel on page 68).
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2.

Open the PCI card retention clamp. Press the retention clamp levers down to unsnap, and then
rotate them up (1).
Figure 4-32 Removing an IEEE-1394 card

3.

Disconnect the front I/O cable and power cable from the card (2).

4.

Lift the IEEE-1394 card out of the chassis (3). Store the card in an anti static bag.

5.

Install a PCI slot cover and close the PCI card retention clamp. If the PCI levers do not close, ensure
that all cards are properly seated, and then try again.

NOTE:

To install an IEEE-1394 card, reverse the previous steps.

Front PCI card guide and fan removal (optional)
This unit acts as a front fan housing and card guide. This section describes how to remove and replace
the fan housing/card guide and the front fan.
NOTE: The fan is only used for special configurations, but the card guide is used with all full-length
add-in cards.

Removing the front PCI card guide and fan
To remove the front PCI card guide and fan:
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the front bezel
(Removing the front bezel on page 68).
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2.

Disconnect the fan wire from the connector on the system board and thread it out of the card guide
(1).
Figure 4-33 Removing the front fan housing/card guide

3.

Unsnap the fan housing/card guide from the chassis (2) and lift it out of the chassis (3).

4.

Remove the fan from the fan housing/card guide by applying outward pressure on the fan housing
while pushing the fan out of the housing.
Figure 4-34 Removing the fan from fan housing/card guide

NOTE: To replace the front fan, reverse the previous steps, ensuring that the airflow direction arrow
on the side of the fan points to the rear of the chassis.

Battery
This section describes how to remove and install the battery.
The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.
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WARNING! This workstation includes a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 60°C (140°F).
CAUTION: Before removing the battery, ensure that the CMOS settings are backed up in case they
are lost when the battery is removed. To back up the CMOS settings, select the Save to Diskette option
in the Computer Setup (F10) Utility.
NOTE: Batteries, battery packs, and accumulators should not be disposed of together with general
household waste.

Removing the battery
To remove the battery:
1.

Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).

2.

On the system board, press the release tab of the battery holder.

3.

Rotate the battery just enough to get beyond the latch, and then lift it straight up.

Installing the battery
To install the battery:
1.

Confirm the polarity (positive or negative) of the battery to position it correctly in the battery holder.

2.

Place the battery edge under the plastic housing tab.
Figure 4-35 Removing the battery

3.
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Press down on the battery until the metal snaps engage.
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Power connections to drives
For help identifying power cables, see the following figure. Ensure that all cables are routed or tied so
that they cannot interfere with the processor heatsink fans.
Figure 4-36 Identifying Identifying workstation power connectors for a typical configurationIdentifying

Table 4-8 Workstation power connector description
Item
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Description

1

Power supply

2

P8

3

P6P7

4

P4/P5

5

Optical drive 1

6

Optical drive 2 and Hard drive 4

7

Optical drive 3 and Hard drive 3

8

Diskette

9

P11

10

Hard drive 2

11

Hard drive 1

12

P10
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Table 4-8 Workstation power connector description (continued)
Item

Description

13

P9

14

P1

15

P13

16

1394 card

17

P12

18

Graphics card

19

P3

Optical drive (minitower configuration)
This section describes how to remove and install an optical disk drive in a minitower workstation
configuration.

Removing an optical drive (minitower configuration)
1.

Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the front bezel
(Removing the front bezel on page 68).

2.

Disconnect the power (1) and data (2) cables from the optical drive.
Figure 4-37 Disconnecting the optical drive cables
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3.

Lift the green drive-lock release lever (1) and gently slide the drive out of the chassis (2).
Figure 4-38 Removing the optical drive from the chassis

4.

After removing the optical drive (1), if you plan to install another drive, remove only the four guide
screws from the drive casing (2).
Figure 4-39 Removing the optical drive screws

Installing an optical drive (minitower configuration)
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the front bezel
(Removing the front bezel on page 68).
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2.

Insert the four black metric M3 guide screws into the drive casing (1).
Figure 4-40 Installing the optical drive

3.

Align the screws with the grooves in the drive bay, and then gently slide the drive into the
workstation until it snaps into place (2).
CAUTION: Ensure that the optical drive is secure in the workstation chassis by pulling on the
drive to see if it can become easily disengaged. Failure to properly secure the drive can damage
the drive when moving the workstation.

4.

Connect the power and data cables to the drive and system board.

NOTE: SATA optical drives can be configured in a workstation with SATA hard drives. When the SATA
Configuration Mode for this workstations is set to:
IDE Mode—Only SATA ports 0 and 2 are functional for any SATA devices.
AHCI Mode—All SATA ports are functional for any SATA devices.
RAID + AHCI Mode—You will not be able to update system BIOS from the SATA optical drive.

Optical drive (desktop configuration)
This section describes how to remove and install an optical drive in the workstation desktop
configuration.

Removing an optical drive (desktop configuration)
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64) and then remove the front bezel
(Removing the front bezel on page 68).
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2.

Disconnect the data (1), power (2) cables from the drive. The connector colors might be different
than shown in the following figure.
Figure 4-41 Disconnecting the optical drive cables

3.

Press down on the yellow drive-lock release lever (1) and gently slide the drive out of the chassis
(2).
Figure 4-42 Removing the optical drive from chassis
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4.

After pulling the drive out (1), if you plan to install another drive, remove only the four guide screws
from the drive (2).
Figure 4-43 Removing the optical drive screws

Installing an optical drive (desktop configuration)
1.

Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), remove the front bezel (Removing
the front bezel on page 68), and then remove the bezel blank (Removing bezel blanks
on page 68) where the drive is being added.

2.

Install the four black metric M3 guide screws into the drive (1).
Figure 4-44 Installing the optical drive

3.

Align the screws with the grooves in the drive bay and gently slide the drive into the casing until it
snaps into place (2).
CAUTION: Ensure that the optical drive is secure in the workstation chassis by pulling the drive
to see if it can become disengaged. Failure to properly secure the drive can cause damage to the
drive when moving the workstation.

4.

Connect the power and drive cables to the drive and system board.
NOTE: SATA optical drives can be configured in a workstation with SATA hard drives. When the
SATA Configuration Mode for this workstations is set to:
IDE Mode—Only SATA ports 0 and 2 are functional for any SATA devices.
AHCI Mode—All SATA ports are functional for any SATA devices.
RAID + AHCI Mode—You will not be able to update system BIOS from the SATA optical drive.
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Diskette drive (optional)
This section describes how to remove and install a diskette drive.

Removing a diskette drive
1.

Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the front bezel
(Removing the front bezel on page 68).

2.

Disconnect the power (1) and data (2) cables from the back of the diskette drive.
Figure 4-45 Disconnecting the diskette drive cables

3.

Lift the green drive-lock release tab (1) and gently slide the drive out of the chassis at the same
time (2).
Figure 4-46 Removing the diskette drive from chassis

NOTE: To install a diskette drive, reverse the previous steps. You might need to remove the front bezel
to install the drive.
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SAS hard drive
This section describes how to remove and install a SAS hard drive.

Removing a SAS hard drive
1.

Disconnect power from the system (Predisassembly procedures on page 58), and then remove
the side access panel (Removing the side access panel on page 64).

2.

Disconnect the power (1) and data (2) cables from the hard drive.
Figure 4-47 Disconnecting the SAS hard drive cables

3.

Lift the green drive-lock release tab (1), and then slide the hard drive out of the chassis (2).
Figure 4-48 Removing the SAS hard drive
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4.

Remove the four guide screws from the hard drive and retain them for later use.

Installing a SAS hard drive
1.

Disconnect power from the system (Predisassembly procedures on page 58), and then remove
the side access panel (Removing the side access panel on page 64).

2.

Attach a SAS-to-SATA cable adapter to the connector on the SAS hard drive.
Figure 4-49 Attaching the SAS-SATA adapter to the SAS hard drive

3.
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Install the four silver, ANSI 6–32 guide screws into the hard drive.
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4.

Push the drive into the selected bay until it snaps into place (1).
Figure 4-50 Installing the SAS hard drive

5.

Attach the power (2) and data (3) cables to the SAS drive.

6.

Insert the SAS controller card into an available PCI slot in the workstation chassis.

7.

Connect the data cable from the hard drive (1) to the controller card (2).
Figure 4-51 Connecting the SAS cable to SAS hard drive

8.

If necessary, install the SAS card in an empty PCI Express slot, and then install the LED cable from
the card to the system board. You can find the location of this connector on the service label on
the inside of the side access panel.

NOTE: To install three or four SAS drives, install the third and fourth drives in the workstation optical
drive bays. See Installing SATA hard drives in the optical drive bays (optional) on page 102 for
instructions.
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SATA hard drive
For more information about SATA hard drives and SATA RAID configurations, see Configuring RAID
devices on page 141.
This section describes how to remove and install a SATA hard drive.

Removing a SATA hard drive
To remove a SATA hard drive:
1.

Disconnect power from the system (Predisassembly procedures on page 58), and then remove
the side access panel (Removing the side access panel on page 64).

2.

Disconnect the data (1) and power (2) cables from the SATA hard drive.
Figure 4-52 Disconnecting the SATA hard drive cables
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3.

Lift the green drive-lock release tab (1) and slide the hard drive out of the chassis (2).
Figure 4-53 Removing the SATA hard drive

4.

Remove the four guide screws from the hard drive and retain them for later use.

Installing a SATA hard drive
To install one or two SATA hard drives:
1.

Disconnect power from the system (Predisassembly procedures on page 58), and then remove
the side access panel (Removing the side access panel on page 64).

2.

Select a drive bay in which to install the SATA hard drive.

3.

Install the four silver, ANSI 6–32 guide screws into the hard drive.

4.

Slide the SATA drive into the selected bay until it snaps into place.
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5.

Attach the data (1) and power (2) cables to the SATA drive.
Figure 4-54 Connecting the SATA cables to the SATA drive

6.

For a single SATA drive, connect the SATA 0 data cable from the hard drive (1) to the SATA0 port
(2) in the workstation chassis.
For a second SATA drive, connect the SATA 1 data cable from the hard drive to the SATA1 port
in the workstation chassis.
Figure 4-55 Connecting the SATA data cable to the workstation SATA port

NOTE: To install three or four SATA drives, install the third and fourth drives in the workstation optical
bays. See Installing SATA hard drives in the optical drive bays (optional) on page 102 for instructions.
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Installing SATA hard drives in the optical drive bays (optional)
1.

If necessary, remove the EMI shield.

2.

Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the front bezel
(Removing the front bezel on page 68).

3.

Place the SATA hard drive in the drive bracket (1), and then install four silver, ANSI 6–32 screws
through the bracket and into the hard drive as shown in the following figure (2).
Figure 4-56 Installing the hard drive in bracket

4.

Install additional black, metric M3 screws into the bracket (1). Align the screws with the grooves in
the optical drive bay, and then slide the drive into the workstation chassis (2).
Figure 4-57 Installing the hard drive in the optical drive bay
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5.

Connect the data cable to the hard drive (1) and to the system board (2).
Figure 4-58 Connecting the data cable

6.

Connect the power cable (not shown).

Processor heatsink
This section describes how to remove and install a processor heatsink.
NOTE: Not all heatsinks are the same. Therefore, the heatsink shown in the following figures is an
example of what might be installed in your workstation.

Removing the processor heatsink
To remove a heatsink:
1.
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Power down the workstation (Predisassembly procedures on page 58), disconnect power from the
workstation (Predisassembly procedures on page 58), and then remove the side access panel
(Removing the side access panel on page 64).
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2.

Slowly and evenly loosen one pair of diagonally opposite screws (1) from the processor until the
screw shanks disengage from the system board. Loosen the remaining pair (2).
CAUTION: Do not fully loosen one screw, and then move on to the next. Loosen all screws a
little at a time, ensuring that the processor remains level.
Figure 4-59 Identify proper screw loosening sequence

3.

Disconnect the processor heatsink fan cable from the system board (1).

4.

Gently twist the heatsink to break the thermal grease binding.

5.

Lift the processor heatsink out of the chassis (2).
Figure 4-60 Removing the processor heatsink

6.

Use alcohol and a soft cloth to clean all of the thermal interface residue from the processor and
the heatsink.
CAUTION:

Allow the alcohol on the processor and processor heatsink to dry completely.
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Installing the processor heatsink
To install a heatsink:
1.

Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64). and then remove the processor
heatsink (Removing the processor heatsink on page 103).

2.

If reusing the original heatsink, apply thermal grease to the center of the processor top surface. If
using a new processor heatsink, do not apply thermal grease to the processor; the a new heat sink
will have grease already applied to the heatsink surface. In this case, discard the thermal grease
protective liner from the bottom of the new heatsink before installing.

3.

Carefully seat the processor heatsink onto the system board.
CAUTION: Do not overtighten the heatsink screws. If you overtighten them, you might strip the
threads in the system board tray.

4.

Carefully tighten the four screws a little at a time, that is, do not fully tighten one screw and move
onto the next. If you have a torque-limited driver available, tighten the screws to 6 in-lbs.
CAUTION: Ensure that the processor remains level as you tighten the screws.

System processor
This section describes how to remove and install a system processor.

Removing a system processor
1.
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Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), and then remove the processor
heatsink (Removing the processor heatsink on page 103).
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2.

Raise the processor socket lever (1) and open the cover (2).
Figure 4-61 Removing the system processor

CAUTION: The processor socket contacts are delicate. To avoid bending the contacts, use
extreme care when handling the processor.
3.

Pull the processor straight out of the socket (3).
CAUTION: Do not touch the processor socket pins or the gold pads underneath the processor.
Handle the processor by the edges.

NOTE:

Store the processor in a static free container in a safe place where it cannot be damaged.

Installing a system processor
1.

Disconnect power from the system (Predisassembly procedures on page 58), remove the side
access panel (Removing the side access panel on page 64), remove the processor heatsink
(Removing the processor heatsink on page 103), and then remove the processor (Removing a
system processor on page 105).

2.

Raise the processor socket lever and cover fully.
CAUTION: The processor socket contacts are delicate. To avoid bending the contacts, use
extreme care when installing the processor in the socket.
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3.

Align the triangle on the top of the processor with the triangle on the corner of the processor socket,
and then install the processor into the socket. Ensure that the underside of the processor is level
with the top of the processor socket. Close the socket cover and lightly press down on processor
while closing the socket lever.
Figure 4-62 Seating the processor

System board
This section describes removing and installing the system board.

Removing the system board
To remove the system board:
1.

Disconnect power from the system (Predisassembly procedures on page 58) and remove the side
access panel (Removing the side access panel on page 64).
NOTE: Although the processor heatsink can remain in place, you might want to remove it for
convenience.

2.

Remove all expansion boards and graphics cards (Removing a PCI Express card on page 81,
Removing a PCI card on page 83), and then remove the processor heatsink (Removing the
processor heatsink on page 103).
TIP: Make a note of the cable connections before disconnecting them from the system board.
For more information, refer to Power connections to drives on page 89 .

3.
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Disconnect all cabling from the system board.
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4.

Press the release tab as shown in the following illustration (1).
Figure 4-63 Removing the system board

5.

Slide the system board toward the front of the chassis and then lift it out of the workstation (2).

Installing the system board
To install the system board:
1.

Set the system board in the chassis, slightly away from the rear of the chassis. The mounting hooks
will seat in the recesses of the tray so that the tray lies flat on the chassis base.

2.

Slide the tray towards the rear of the chassis until the heat sink mounting holes are aligned.

3.

Reinstall the processor heatsink, cards, and cables.

Product recycling
The Planet Partners recycling service provides an easy way to recycle computer equipment,
rechargeable batteries, or HP printing supplies. HP processes ensure that unwanted hardware or empty
HP printing supplies are recycled responsibly.
For information about recycling HP components or products, visit http://www.hp.com/go/recycle.
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5

System diagnostics and
troubleshooting

This chapter describes the tools available for diagnosing and troubleshooting system issues, and
includes the following topics:

ENWW

●

Customer Self Help on page 110

●

Troubleshooting checklist on page 129

●

LED color definitions on page 129

●

HP Insight Diagnostics Offline Edition on page 131

●

POST error messages on page 135
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Customer Self Help
Help and Support Center
The HP Help and Support Center (HSC) provides online access to technical support information,
software updates and downloads, diagnostic tools, and HP support contact information.
To open the online HSC from your desktop, select Start>Help and Support.
HSC contains four support areas:
●

HP Product Information (requires Internet access)—Links to the HP Technical Support website for
your product. You can access all related documentation, downloads and updates, tools, and more.

●

HP Software and Driver Downloads (requires Internet access)—Links to software downloads and
updates specific to HP products.

●

HP Support Tools (requires Internet access)—Links to self-help tools and diagnostics offered by
HP Instant Support Professional Edition.

●

Contact HP for Support (does not require Internet access)—Provides two options:
◦

Chat with an expert online (requires Internet access)—Provides a tool to communicate with
a support specialist online through Active Chat.

◦

Call a support agent—Provides hardware details about your workstation and HP support
phone numbers worldwide.

HP SoftPaq Download Manager
The HP SoftPaq Download Manager enables you to download software updates for your workstation
from the HP support site. To use the download manager:
1.

Go to http://h20331.www2.hp.com/Hpsub/cache/509658-0-0-225-121.html.

2.

Select your workstation model, operating system, and language, and then click Find Available
SoftPaqs. All available SoftPaqs matching the selected criteria are displayed.

3.

Select the updates you want to download.

4.

Select Download.

Diagnostic LED codes
NOTE: Workstation beeps are emitted from the onboard piezo speaker, the chassis speaker. The
flashing lights and beeps repeat for five cycles. After five cycles, only the flashing lights repeat.
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Table 5-1 Diagnostic LED codes
Chassis indicator LEDs
Power LED and sound
activity

Diagnosis and service action

None

Workstation does not power on. Press the power button. If the hard drive LED is
GREEN, then:
1.

Remove expansion cards one at a time.

2.

Replace the system board.

OR
Press the power button. If the hard drive LED does not illuminate, then:

Blinks red 2 times (once per
second), then a 2–second
pause, and then 2 beeps

Blinks red 3 times (once per
second), then a 2-second
pause, and then 3 beeps

ENWW

1.

Verify that the workstation is plugged into a working AC outlet.

2.

Open the access panel and verify that the power button harness is properly
connected to the inline front panel I/O device assembly connector.

3.

Verify that the power supply cables are properly connected to the system board.

4.

Verify power supply functionality.
a.

Disconnect AC power.

b.

Remove all internal power supply cables from the system board.

c.

Plug in AC power.

◦

If the power supply fan spins and the BIST LED illuminates, then the power
supply is good. Replace the system board.

◦

If the power supply fan does not spin or the BIST LED does not illuminate,
then replace the power supply.

Thermal shutdown has occurred:
1.

Ensure that the workstation air vents are not blocked and the cooling fan is
running.

2.

Open the access panel, press power button, and determine whether the processor
fan spins. If it does not spin, ensure the fan cable is plugged into the system board.
Ensure that the fan is properly seated.

3.

If the fan is plugged in and seated but not spinning, then replace processor fan.

4.

Reseat the processor heatsink and verify that the fan assembly is properly
attached.

Processor not installed
1.

Install processor.

2.

Reseat processor.
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Table 5-1 Diagnostic LED codes (continued)
Chassis indicator LEDs
Power LED and sound
activity

Diagnosis and service action

Blinks red 4 times (once per
second), then a 2-second
pause, and then 4 beeps

Power supply failure.

Blinks red 5 times (once per
second), then a 2-second
pause, and then 5 beeps

Blinks red 6 times (once per
second), then a 2-second
pause, and then 6 beeps

1.

Open the access panel, and be sure the four-wire power supply cable is properly
connected to the system board.

2.

Locate a faulty device by removing all devices and then reinstalling one at a time
until the workstation fails. Replace the device causing the failure. Continue adding
devices to ensure all are functioning properly.

3.

Verify the power supply functionality.
a.

Disconnect AC power.

b.

Remove all internal power supply cables from the system board.

c.

Plug in AC power.
●

If the power supply fan spins and the BIST LED illuminates, then the
power supply is good. Replace the system board.

●

If the power supply fan does not spin or the BIST LED does not
illuminate, replace the power supply.

Pre-video memory error.
1.

Reseat memory modules.

2.

Replace memory modules one at a time to find the faulty module.

3.

Replace third-party modules with HP memory.

4.

Replace the system board.

Pre-video graphic card error.
For systems with integrated graphics, replace the system board.
For systems with graphic cards:
Pre-video graphic card error. For systems with integrated graphics, replace the system
board. For systems with graphic cards:

Blinks red 7 times (once per
second), then a 2-second
pause, and then 7 beeps

1.

Reseat the graphic card. Power on the workstation.

2.

Replace the graphic card.

3.

Replace the system board.

System board failure (ROM detected a failure before video).
Replace system board.
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Table 5-1 Diagnostic LED codes (continued)
Chassis indicator LEDs
Power LED and sound
activity

Diagnosis and service action

Blinks red 8 times (once per
second), then a 2-second
pause, and then 8 beeps

Invalid ROM based on bad checksum.

Blinks red 9 times (once per
second), then a 2-second
pause, and then 9 beeps

1.

Reflash the ROM.

2.

Replace the system board.

System powers on, but is unable to boot.
1.

Replace the system board.

2.

Replace the processor.

Troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible
solutions for each.

Solving minor problems
Table 5-2 Minor problems
Problem
Workstation appears frozen
and does not shut down when
the power button is pressed.

Workstation seems to be
frozen.
Workstation date and time
display is incorrect.

Cause
Software control of the power
switch is not functional.

Program in use has stopped
responding to commands.
Real-time clock (RTC) battery
might need replacement.

1.

Press and hold the power button for at least four
seconds until the workstation shuts down.

2.

Disconnect the electrical plug from outlet.

3.

Restart the workstation.

1.

Attempt the normal Windows shutdown procedure.

2.

Restart the workstation using the power button.

1.

Reset the date and time under the Control Panel.

2.

Replace the RTC battery.

Workstation appears to pause
periodically.

Network driver is loaded and no
network connection is
established.

Establish a network connection, or use the Computer Setup
(F10) Utility or the Microsoft Windows Device Manager to
disable the network controller.

Cursor does not move using
the arrow keys on the keypad.

The Num Lock key might be on.

Press the Num Lock key. The Num Lock key can be
disabled (or enabled) in the Computer Setup (F10) Utility.

Poor performance is
experienced.

Processor is hot.

1.

Be sure airflow to the workstation is not blocked.

2.

Be sure the fans are connected and working properly
(some fans only operate when needed).

3.

Be sure the processor heatsink is installed properly.

Hard drive is full.
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Possible Solution

Transfer data from the hard drive to create more space on
the hard drive.
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Table 5-2 Minor problems (continued)
Problem
Workstation powered off
automatically and the Power
LED flashes red 2 times (once
every second), followed by a 2second pause, and then two
simultaneous beeps sounded.

Cause
Processor thermal protection
activated.

1.

Be sure workstation air vents are not blocked and the
cooling fan is running.

A fan might be blocked or not
turning.

2.

Open the access panel, press the power button, and
then verify that the processor fan spins. If not spinning,
ensure that the fan cable is plugged into the system
board header. Ensure that the fan is fully/properly
seated or installed.

3.

Replace the processor fan.

4.

Reseat processor heatsink and verify that the fan
assembly is properly attached.

OR
The processor heatsink is not
properly attached to
the processor.

System does not power on,
and the LEDs on the front of
the workstation are not
flashing.

Possible Solution

System is unable to power on.

Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:
1.

Remove the expansion cards.

2.

Replace the system board.

OR
OR Press and hold the power button for less than 4 seconds.
If the hard drive LED does not illuminate, then:
Press and hold the power button for less than 4 seconds. If
the hard drive LED does not illuminate, then:
Press and hold the power button for less than 4 seconds. If
the hard drive LED does not illuminate, then:
1.

Verify that the workstation is plugged into a working AC
outlet.

2.

Open the access panel and verify that the power button
harness is properly connected to the inline front panel
I/O device assembly connector.

3.

Verify that the power supply cables are properly
connected to the system board.

4.

Verify the power supply functionality:
a.

Disconnect AC power.

b.

Remove all internal power supply cables from the
system board.

c.

Plug in AC power.
●

If the power supply fan spins and the BIST
LED illuminates, then the power supply is
good. Replace the system board.

●

If the power supply fan does not spin or the
BIST LED does not illuminate, replace the
power supply.

Solving power supply problems
This section presents power supply troubleshooting scenarios.
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Testing power supply
Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply
still works.
To test the power supply:
1.

Unplug the AC power.

2.

Disconnect all internal power supply cables from the system board.

3.

Plug in AC power.
●

If the green BIST LED (illustrated below) on the rear of the workstation is illuminated and the
fan is spinning, the power supply is functional.

●

If the green BIST LED is not illuminated or the fan is not spinning, replace the power supply.

Figure 5-1 Testing power supply with BIST LED

Table 5-3 Power supply problems
Problem
Power supply shuts down
intermittently.
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Cause
Power supply fault.

Solution
Replace the power supply.
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Table 5-3 Power supply problems (continued)
Problem

Cause

Solution

Workstation powered off
automatically and the Power LED
flashes red 2 times (once every
second), followed by a 2-second
pause.

Processor thermal protection
activated.

1.

Be sure that the workstation air vents are not blocked
and the cooling fan is running.

A fan might be blocked or not
turning.

2.

Open the access panel, press the power button, and
determine whether the processor fan spins. If the
processor fan is not spinning, be sure the fan’s cable
is plugged into the system board header. Be sure the
fan is properly seated or installed.

3.

Replace the processor fan.

4.

Reseat processor heatsink and verify that the fan
assembly is properly attached.

1.

Determine whether a device is causing the problem
by removing all attached devices. Power on the
system. If the system enters the POST, then power
off and replace one device at a time and repeat this
procedure until a failure occurs. Replace the device
causing the failure. Continue adding devices one at a
time to ensure all devices are functioning properly.

2.

Verify the power supply functionality.

OR
The processor heatsink fan
assembly is not properly
attached to the processor.

Power LED flashes red (once every
2 seconds).

Power failure (power supply is
overloaded).

a.

Disconnect AC power.

b.

Remove all internal power supply cables from
the system board.

c.

Plug in AC power.
●

If the power supply fan spins and the BIST
LED illuminates, then the power supply is
good. Replace the system board.

●

If the power supply fan does not spin or the
BIST LED does not illuminate, replace the
power supply.

Solving diskette problems
Table 5-4 Diskette problems
Problem
Diskette drive light stays on.

Drive not found.

Diskette drive cannot write to a
diskette.

Cause

Solution

Diskette is damaged.

Right-click Start, select Explore, and then select a drive.
Select File>Properties>Tools. Under Error-checking,
select Check Now.

Diskette is incorrectly inserted.

Remove and reinsert diskette.

Files on diskette are damaged.

Verify the program diskettes.

Drive cable is not properly
connected.

Reconnect power cable. Be sure that all four pins are
connected.

Cable is loose.

Reseat diskette drive data and power cables.

Removable drive is not seated
properly.

Reseat the drive.

Diskette is not formatted.

Format the diskette.
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Table 5-4 Diskette problems (continued)
Problem

Cause

Solution

Diskette is write-protected.

Use another diskette or remove the write protection.

Writing to the wrong drive.

Verify the drive letter in the path statement.

Not enough space is left on the
diskette.

Use another diskette.

Diskette write-control is
enabled.

Use the Computer Setup (F10) Utility to verify the storage
security feature disabled settings.

Diskette is damaged.

Replace the damaged disk.

Cannot format diskette.

Invalid media reported.

When formatting a disk in MS-DOS, you might need to
specify diskette capacity. For example, to format a 1.44–
MB diskette, enter the following command at the MSDOS prompt: FORMAT A: /F:1440

A problem has occurred with a disk
transaction.

The directory structure is bad,
or there is a problem with a file.

Right-click Start, select Explore, and then select a drive.
Select File>Properties>Tools. Under Error-checking,
select Check Now.

Diskette drive cannot read
a diskette.

Diskette is not formatted.

Format the diskette.

You are using the wrong
diskette type for the drive type.

Verify the type of drive that you are using and use the
correct diskette type.

You are reading the wrong
drive.

Verify the drive letter in the path statement.

Diskette is damaged.

Replace the diskette with a new one.

“Invalid system disk” message is
displayed.

Cannot Boot to Diskette.

A diskette that does not contain When drive activity stops, remove the diskette and press
the system files needed to start the Spacebar. The workstation should start up.
the workstation has been
inserted into the drive.
Diskette error has occurred.

Restart the workstation by pressing the power button.

Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been
disabled in Computer Setup.

Run Computer Setup and enable diskette boot in
Storage>Boot Order.

Removable media boot has
been disabled in Computer
Setup.

Run Computer Setup and enable Removable Media Boot
in Storage>Storage Options.

Diskette MBR validation is
enabled.

Run the Computer Setup (F10) Utility and disable
Diskette MBR Validation in Storage>Storage Options.

Solving hard drive problems
Table 5-5 Hard drive problems
Problem
Hard drive error occurs.

Cause
Hard disk has bad sectors or
has failed.

Solution
Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.
Or, if the drive is detected by the BIOS, then run DPS Selftest .
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Table 5-5 Hard drive problems (continued)
Problem

Cause

Solution

Disk transaction problem.

The directory structure is bad,
or there is a problem with a file.

Right-click Start, select Explore, and select a drive.
Select File>Properties>Tools. Under Error-checking,
select Check Now.

Drive not found (identified).

Loose cable.

Verify cable connections.

The system might not have
automatically recognized a
newly installed device.

1.

Run the Computer Setup (F10) Utility.

2.

If the system still does not recognize the new device,
verify that the device is listed in the Computer Setup
(F10) Utility. If it is listed, the probable cause is a driver
problem. If it is not listed, the probable cause is a
hardware problem.

3.

If this drive is newly installed, enter Setup and try
adding a POST delay under Advanced>Power-On.

Nonsystem disk or NTLDR missing
message.

Drive jumper settings might be
incorrect.

If the drive is a secondary drive that has just been installed
on the same cable as the primary drive, verify that the
jumpers for both drives are set correctly.

Drive responds slowly
immediately after power-up.

Run the Computer Setup (F10 utility, and then increase the
POST Delay in Advanced>Power-On Options.

System is trying to start from a
nonbootable diskette.

Remove the diskette from the diskette drive.

System is trying to start from a
damaged hard drive.

1.

Insert a bootable diskette into the diskette drive and
restart the workstation.

2.

If the hard drive is still inaccessible and MBR Security
is enabled, try restoring the previously saved
MBR image by entering Setup, and then selecting
Security>Restore Master Boot Record.

1.

Insert a bootable system diskette and restart.

2.

Verify that the hard drive is partitioned and formatted.

3.

Install the system files for the appropriate operating
system, if necessary.

System files missing or not
properly installed.

Workstation will not start.

Hard drive boot disabled in
Computer Setup.

Run the Computer Setup (F10) Utility, and then enable the
hard drive entry in the Storage>Boot Order list.

Hard drive is damaged.

Observe the beeps and LEDs on the front of the
workstation. Refer to POST error messages
on page 135.

Solving display problems
Table 5-6 Display problems
Problem
Blank screen (no video).

Cause

Solution

The cable connections are not
correct.

Verify the cable connections from the monitor to the
workstation and to a working electrical outlet.

The monitor is off.

Switch the monitor on (LED is on). You might need to refer
to the monitor manual for an explanation of the LED
signals.
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Table 5-6 Display problems (continued)
Problem

Cause

Solution

Screen blanking utility installed
or energy saver features
enabled.

Press any key or press the mouse button, and, if set, enter
your password.

System ROM is bad; system is Reflash the ROM using a SoftPaq.
running in FailSafe Boot Block
mode (indicated by 8 beeps).

The display works properly during
the POST but goes blank when the
operating system starts.

Power LED flashes red 6 times
(once every second), followed by a
2–second pause, and then the
workstation beeps 6 times.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution specified.

Computer is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Workstation monitor settings
are not compatible with the
monitor.

1.

When you see Press F8 in the bottom-right corner of
the screen, restart the workstation and press F8
during startup.

2.

Using the keyboard arrow keys, select Enable VGA
Mode and then press Enter.

3.

In Windows Control Panel, double-click the Display
icon and then select the Settings tab.

4.

Use the sliding control to reset the resolution.

1.

Restart your workstation in VGA mode.

2.

After the operating system starts, change the display
settings to match those supported by your graphics
card and monitor.

3.

Refer to your operating system and graphics card
documentation for information about changing display
settings.

The display settings in the
operating system are
incompatible with your
graphics card and monitor.

Pre-video graphics error.

For systems with a graphics card:
1.

Reseat the graphics card.

2.

Replace the graphics card.

3.

Replace the system board.

Monitor does not function properly
when used with Energy Saver
features.

Monitor without Energy Saver
capabilities is being used with
Energy Saver features
enabled.

Disable monitor Energy Saver feature.

Dim characters

The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly
connected.

Verify that the graphics cable is securely connected to the
graphics card and the monitor.

If the graphics controller was
upgraded, the correct video
drivers might not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of
displaying requested
resolution.

Change requested resolution.

Blurry video or requested
resolution cannot be set.
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Fixed-sync monitor does not
sync at the resolution
specified.
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Table 5-6 Display problems (continued)
Problem
The picture is broken up, rolls,
jitters, or flashes.

Cause
The monitor connections might
be incomplete, or the monitor
might be incorrectly adjusted.

Solution
1.

Be sure the monitor cable is securely connected to the
workstation.

2.

In a two-monitor system, or if another monitor is in
close proximity, ensure that the monitors are not
interfering with each other’s electromagnetic field by
moving them apart.

3.

Fluorescent lights or fans might be too close to the
monitor.

Monitor must be degaussed.

Degauss the monitor.

Vibrating or rattling noise coming
from inside a CRT monitor when
powered on.

Monitor degaussing coil has
been activated.

None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a
CRT monitor.

Electronic relays have been
activated inside the monitor.

None. It is normal for some monitors to make a clicking
noise when turned on and off, when going in and out of
Standby mode, and when changing resolutions.

High pitched noise coming from
inside a flat-panel monitor.

Brightness and contrast
settings are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, ghosting,
or shadowing effects; horizontal
scrolling lines; faint vertical bars; or
unable to center the picture on the
screen (flat-panel monitors using
an analog VGA input connection
only.)

Flat-panel monitor’s internal
digital conversion circuits
might be unable to correctly
interpret the output
synchronization of the
graphics card.

1.

Select the monitor’s Auto-Adjustment option in the
monitor’s onscreen display menu.

2.

Manually synchronize the Clock and Clock Phase
onscreen display functions. Download SoftPaq
SP20930 or SP22333 (depending on the monitor) to
assist with the synchronization).

Certain typed symbols do not
appear correctly.

The font you are using does
not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. Select Start>All Programs>
Accessories>System Tools>Character Map. You can
copy the symbol from the Character Map into a document.

Solving audio problems
Table 5-7 Audio problems
Problem
Sound does not come out of the
speaker or headphones.

Cause

Solution

Software volume control is
turned down.

Double-click the Speaker icon on the taskbar and use the
volume slider to adjust the volume.

The external speakers are not
turned on.

Turn on the external speakers.

External speakers plugged into
the wrong audio jack.

See your sound card documentation for proper speaker
connection.

Audio cable not connected.

Connect audio cable between CD or DVD-ROM drive and
the system board.

Digital CD audio is
not enabled.

Enable digital CD audio:
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1.

From the Control Panel, select System.

2.

On the Hardware tab, select the Device Manager
button.
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Table 5-7 Audio problems (continued)
Problem

Cause

Solution
3.

Right-click the CD/DVD device and select
Properties.

4.

On the Properties tab, ensure that Enable digital CD
audio for this CD-ROM device is selected.

Headphones or devices
connected to the line-out
connector have muted the
internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external
speakers.

Volume is muted.

1.

From the Control Panel, select Sound, Speech and
Audio Devices, and then select Sounds and Audio
Devices.

2.

Deselect the Mute checkbox.

Computer is in Standby mode.
Noise or no sound comes out of the
speakers or headphones.

Press the power button to resume from Standby mode.
1.

If using digital speakers that have a stereo jack and
you want the system to auto switch to digital, use a
stereo-to-mono adapter to properly engage the auto
sense feature, or use the multimedia device
properties to manually switch the audio signal from
analog to digital.

2.

If the headphones have a mono jack, use the
multimedia device properties to switch the system to
analog out.

NOTE: If you set digital as the Output Mode, the internal speaker and external analog speakers no longer output audio until you
switch back to an auto sense or analog mode.
If you set analog as the Output Mode, external digital speakers do not function until you change the output mode back to an autosense or digital mode.
Sound occurs intermittently.

Processor resources are being
used by other open
applications.

Shut down all open processor-intensive applications.

Workstation appears to be locked
up while recording audio.

The hard disk might be full.

1.

Before recording, be sure there is enough free space
on the hard disk.

2.

Try recording the audio file in a compressed format.

Solving printer problems
Table 5-8 Printer problems
Problem
Printer does not print.

Cause

Solution

Printer is not turned on and
online.

Turn the printer on and be sure it is online.

The correct printer driver for
the application is not installed.

1.

Install the correct printer driver for the application.

2.

Try printing using the MS-DOS command:
DIR C:\> [printer port]
where printer port is the address of the printer used.
If the printer works, reload the printer driver.
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Table 5-8 Printer problems (continued)
Problem

Cause

Solution

If you are on a network, you
might not have made a
connection to the printer.

Make the proper network connection to the printer.

Printer might have failed.

Run printer self-test.

Printer does not turn on.

The cables might not be
connected properly.

Reconnect all cables.

Printer prints garbled information.

The correct printer driver is not
installed.

Install the correct printer driver for the application.

The cables might not be
connected properly.

Reconnect all cables.

Printer memory might be
overloaded.

Reset the printer by turning it off for one minute, then turn
it back on.

The printer might be out of
paper.

1.

Verify that the paper tray and refill it if it is empty.

2.

Select Online.

Printer is offline.

Solving keyboard and mouse problems
Table 5-9 Keyboard and mouse problems
Problem
Keyboard commands and typing
are not recognized by the
workstation.

Cause
Keyboard connector is not
properly connected.

Solution
1.

Power off the workstation.

2.

Reconnect the keyboard to the back of the
workstation and restart the workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the mouse, and then
restart the workstation.

Keyboard needs repairs.

Replace the keyboard.

Keyboard key is stuck down.

Remove any debris from the keyboard.

Workstation is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Cursor will not move using the
arrow keys on the keypad.

The Num Lock key might be
on.

Press the Num Lock key. The Num Lock light should not
be on if you want to use the arrow keys. The Num Lock key
can be disabled or enabled in the Computer Setup (F10)
Utility.

Mouse does not respond to
movement or is too slow.

Mouse connector is
not properly plugged into the
back of the workstation.

1.

Shut down the workstation using the keyboard.

2.

Plug the mouse connector into the PS/2 mouse
connector slot in the workstation, and then restart the
workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the keyboard and then
restart the workstation.

Mouse needs repairs.

Replace the mouse.
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Table 5-9 Keyboard and mouse problems (continued)
Problem

Mouse only moved vertically or
horizontally, or the movement is
jerky.

Cause

Solution

Workstation is in Standby
mode.

Press the power button to resume from Standby mode.

Mouse rollerball is dirty.

Remove the rollerball cover from the bottom of the mouse,
clean it, and then replace cover.

Solving front panel component problems
If you are experiencing problems with one of the front panel ports, you might be able to try your device
in the corresponding port on the back side of the computer. If this does not fix the problem, or you must
use the front panel ports, continue troubleshooting.
Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.
Table 5-10 Front panel component problems
Problem
A USB device, headphone, or
microphone is not recognized by
the workstation.

Cause
The device is not properly
connected.

The device does not have
power.

A device in the IEEE-1394 port is
not responsive.

The IEEE-1394 port is not active.

1.

Power off the workstation.

2.

Reconnect the device to the front of the workstation
and restart the workstation.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not 1.
installed.
2.

Install the correct driver for the device.

The cable from the device to
the computer does not work.

1.

If possible, replace the cable.

2.

Restart the workstation.

1.

Replace the device.

2.

Restart the workstation.

The internal cables might not
be connected to the system
board or the PCI card.

1.

Power off the workstation.

2.

Connect the cables correctly.

Cables of the external device
are loose, or power cables are
unplugged.

Be sure that all cables are properly and securely
connected.

The power switch on the
device is not turned on.

Power off the workstation, power on the external device,
then power on the workstation to integrate the device
with the workstation system.

The device is not working.

A USB, audio, or IEEE-1394 device
is not working.

Solution

You might need to reboot the workstation.

The port is not there because it You can buy an IEEE 1394 PCI adapter card. Contact an
was not purchased with the
HP seller.
system.

Solving hardware installation problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional
diskette drive. If you install a Plug and Play (PnP) device, the operating system automatically recognizes
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the device and configures the workstation. If you install a nonPnP device, you must reconfigure the
workstation after completing installation of the new hardware.
Table 5-11 Hardware installation problems
Problem
A new device is not recognized as
part of the system.

Workstation does not start.

Power LED flashes red 5 times
(once every second), followed by a
2–second pause, and then the
workstation beeps 5 times.

Power LED flashes red 6 times
(once every second), followed by a
2–second pause, and then the
workstation beeps 6 times.

Cause

Solution

Device is not seated or
connected properly.

Be sure that the device is properly and securely connected
and that pins in the connector are not bent.

Cables of new external device
are loose, or power cables are
unplugged.

Be sure that all cables are properly and securely connected
and that pins in the cable or connector are not bent.

Power switch of new external
device is not turned on.

Power off the workstation, power on the external device,
and then power on the workstation to integrate the device
into the workstation system.

When the system advises you
about changes to the
configuration, you do not
accept them.

Reboot the workstation and follow the instructions for
accepting the changes.

A PnP board might not
automatically configure when
added if the default
configuration conflicts with
other devices.

Use Windows XP Device Manager to deselect the
automatic settings for the board and choose a basic
configuration that does not cause a resource conflict. You
can also use the Computer Setup (F10) Utility to
reconfigure or disable devices to resolve the resource
conflict.

Device hardware is not
properly jumpered or
otherwise configured.

Read the device-specific configuration information and
check for incorrect settings or conflicts with other devices
already installed in the system.

Wrong memory modules were
used in the upgrade, or
memory modules were
installed in the wrong location.

1.

Review the documentation that came with the system
to determine if you are using the correct memory
modules and to verify the proper installation.

2.

Observe the beeps and LEDs on the front of the
workstation. Refer to POST error messages
on page 135 to determine possible causes.

PCI Express power cable
might be plugged into the
wrong connector on the
system board.

Connect the auxiliary PCI Express power cable to the PCI
Express card.

Memory is installed incorrectly
or is bad.

1.

Reseat DIMMs.

2.

Replace DIMMs one at a time to isolate the faulty
module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Video card is not seated
properly or is bad, or system
board is bad.
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For systems with a graphics card:
1.

Reseat the graphics card.

2.

Replace the graphics card.

3.

Replace the system board.
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Solving network problems
The following table provides fixes for common network problems.
Table 5-12 Network problems
Problem

Solution

Wake-on-LAN feature is not
functioning.

Wake-on-LAN is not enabled.

Use the network control application to enable Wake-onLAN.

Network driver does not detect
network controller.

Network controller is disabled.

Run the Computer Setup (F10) Utility to enable network
controller.

Incorrect network driver.

Review the network controller documentation to verify the
correct driver, or obtain the latest driver from the
manufacturer’s website.

Network status link light does not
illuminate or never flashes.

No active network is detected.

Verify cabling and network equipment for proper
connection.

The network status light does not
flash when there is network
activity.

Network controller is not set up
properly.

Use the network control application to verify that the
device is working properly.

Network driver is not properly
loaded.

Reinstall network drivers.

System cannot auto sense the
network.

Disable auto sensing capabilities and force the system
into the correct operating mode.

The cable is not securely
connected.

Be sure that both ends of the data cable are securely
connected.

The cable is attached to the
incorrect connector.

Be sure that the cable is attached to the correct connector.

There is a problem with the cable
or a device at the other end of the
cable.

Be sure that the cable and device at the other end are
operating correctly.

Network controller interrupt is
shared with an expansion board.

Under the Computer Setup (F10) Utility Advanced menu,
change the resource settings for the board.

The network controller
is defective.

Replace the NIC.

Network drivers are not loaded, or
driver parameters do not match
current configuration.

1.

Be sure the network drivers are loaded and that the
driver parameters match the configuration of the
network controller.

2.

Be sure the correct network client and protocol is
installed.

Diagnostics reports a failure.

Diagnostics passes, but the
workstation does not
communicate with the network.

Network controller stopped
working when an expansion
board was added to the
workstation.
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Cause

The network controller is not
configured for this workstation.

Double-click the Network icon in the Control Panel and
configure the network controller.

Network controller interrupt is
shared with an expansion board.

Under the Computer Setup (F10) Utility Advanced menu,
change the resource settings for the board.

The network controller requires
drivers.

Verify that the drivers were not accidentally deleted when
the drivers for the expansion board were installed.
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Table 5-12 Network problems (continued)
Problem

Cause

Solution

The expansion board installed is a
network card and conflicts with the
embedded network card.

Under the Computer Setup (F10) Advanced menu,
change the resource settings for the board.

The files containing the network
drivers are corrupted.

Reinstall the network drivers using the Restore Plus! CD.

The cable is not securely
connected.

Be sure that both ends of the cable are securely attached
to the correct devices.

The network controller is
defective.

Replace the NIC.

New network card does not boot.

New network card might be
defective or might not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the
boot sequence to boot from another source.

Cannot connect to network
server when attempting remote
system installation.

The network controller is not
configured properly.

Verify network connectivity, that a DHCP server is
present, and that the Remote System Installation Server
contains the NIC drivers for your NIC.

Computer Setup (F10) Utility
reports unprogrammed
EEPROM.

Unprogrammed EEPROM.

Flash the ROM.

Network controller stops working
without apparent cause.

Solving memory problems
CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and
nonECC memory. The operating system does not boot with mixed-ECC memory.
Table 5-13 Memory problems
Problem
System does not boot (or does not
function properly) after installing
additional memory modules.

Cause
A memory module is not the
correct type or speed or the
new memory module is not
seated properly.

Solution
Replace module with the correct, industry-standard device
for the workstation.

On some models, ECC and nonECC memory modules
cannot be mixed.
Out of memory error.

Memory configuration might
not be set up correctly.

Use the Device Manager to verify memory configuration.

You have run out of memory to
run the application.

Review the application documentation to determine the
memory requirements.

Memory count during POST is
wrong.

The memory modules might
not be installed correctly.

Verify that the memory modules have been installed
correctly and that proper modules are used.

Insufficient memory error during
operation.

Too many Terminate and Stay
Resident (TSR) programs are
installed.

Delete any TSRs that you do not need.

You have run out of memory
for the application.

Verify the memory requirements for the application or add
more memory to the workstation.

Memory is installed incorrectly
or is bad.

1.

Reseat DIMMs.

2.

Replace DIMMs one at a time to isolate the faulty
module.

Power LED flashes red 5 times
(once every second), followed by a
2-second pause, and then the
workstation beeps 5 times.
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Table 5-13 Memory problems (continued)
Problem

Cause

Solution
3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Solving processor problems
Table 5-14 Processor problems
Problem
Poor performance is experienced.

Power LED is red and stays on.

Cause
Processor is hot.

Processor is not seated
properly or not installed.

Solution
1.

Be sure the airflow to the workstation is not blocked.

2.

Be sure the fans are connected and working properly
(some fans only operate when needed).

3.

Be sure the processor heatsink is installed properly.

1.

Verify that the processor is present.

2.

Reseat the processor.

Solving DVD problems
Table 5-15 DVD problems
Problem
System does not boot from DVD
drive.

DVD devices are not detected or
the driver is not loaded.
Movie does not play in the DVD
drive.

Cannot eject CD (tray-load unit).

CD-RW or DVD-R/RW drive
cannot read a disc or takes too long
to start.
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Cause

Solution

The DVD boot is not enabled
through the Computer Setup
(F10) Utility.

Run the Computer Setup (F10) Utility and enable booting
to removable media and verify boot order settings.

Nonbootable CD in drive.

Try a bootable CD in the drive.

Drive is not connected properly 1.
or not properly configured.
2.

Reconnect power and data cables to the drive.
Install correct device driver.

Movie might be regionalized
for a different country.

See the documentation included with the DVD drive.

Decoder software is not
installed.

Install decoder software.

Disc not properly seated in the
drive.

1.

Power off the workstation and insert a thin metal rod
(such as a paper clip) into the emergency eject hole
and push firmly.

2.

Slowly pull the tray out from the drive until the tray is
fully extended, and then remove the disc.

CD has been inserted upside
down.

Reinsert the CD with the label facing up.

The DVD-ROM drive takes
longer to start because it has to
determine the type of media
played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

DVD disc is dirty.

Clean DVD with a CD cleaning kit.
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Table 5-15 DVD problems (continued)
Problem

Cause
Windows does not detect the
DVD-ROM drive.

Recording audio CDs is difficult or
impossible.

Wrong or poor-quality media
type.

Solution
1.

Use Device Manager to remove or uninstall the
device.

2.

Restart the workstation and allow Windows to detect
the device.

1.

Use a slower recording speed.

2.

Verify that you are using the correct media for the
drive.

3.

Try a different brand of media. Quality varies widely
between manufacturers.

Solving Internet access problems
Table 5-16 Internet access problems
Problem

Cause

Solution

Unable to connect to the Internet.

Internet Service Provider (ISP)
account is not set up properly.

Verify Internet settings or contact the ISP for assistance.

Modem is not set up properly.

Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up
properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/ DSL modem is not
plugged in.

Plug in cable/DSL modem. When properly connected, the
power LED on the front of the cable/DSL modem should be
illuminated.

Cable/DSL service is not
available or has been
interrupted because of bad
weather.

Try connecting to the Internet at a later time, or contact your
ISP. If the cable/DSL service is connected, the cable LED
light on the front of the cable/DSL modem is on.

The CAT5 10/100/1000 cable
is disconnected.

Connect the CAT5 10/100/1000 cable between the cable
modem and the workstations’s RJ-45 connector. (If the
connection is good, the “PC” LED on the front of the cable/
DSL modem will be on.)

IP address is not configured
properly.

Contact the ISP for the correct IP address.

Cookies are corrupted.

1.

Select Start>Control Panel.

2.

Double-click Internet Options.

3.

On the General tab, select the Delete Cookies button.

Cannot automatically launch
Internet programs.

You must log on to the ISP
before some programs will
start.

Log on to the ISP and launch the desired program.

Internet takes too long to download
websites.

Modem is not set up properly.

1.

Select Start>Control Panel.

2.

Double-click System, and then select the Hardware
tab.

3.

In the Device Manager area, select the Device
Manager button.
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Table 5-16 Internet access problems (continued)
Problem

Cause

Solution
4.

Double-click Ports (COM & LPT).

5.

Right-click the COM port that your modem uses, and
then select Properties.

6.

Under Device status, verify that the modem is working
properly.

7.

Under Device usage, verify that the modem is
enabled.

8.

If there are further problems, select the
Troubleshoot button and follow the onscreen
instructions.

Troubleshooting checklist
Before running any of the diagnostic utilities, use the following checklist to find possible solutions for
workstation or software problems.
●

Is the workstation and monitor connected to a working electrical outlet?

●

Is the workstation powered on?

●

Is the green power light illuminated?

●

Is the monitor on?

●

Is the green monitor light illuminated?

●

If the monitor is dim, adjust the monitor brightness and contrast controls .

●

Press and hold any key. If the system beeps, then the keyboard is operating correctly.

●

Check all cables for loose or improper connections.

●

After installing a nonPnP expansion board or other option (such as a diskette drive), reconfigure
the workstation.

●

Are all of the necessary device drivers installed?

●

Have all printer drivers been installed for each application?

●

Have you removed all diskettes and CDs from the drives before you power on the workstation?

●

Are you running the latest version of BIOS, drivers, and software?

LED color definitions
The following table describes what each LED light on your workstation front panel signifies.
Table 5-17 LED color definitions
LED state
Solid
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LED color
Green

System status
System is on
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Table 5-17 LED color definitions (continued)
LED state

LED color

System status

Flashing

Green

System is in Standby

Solid or flashing

Red

System has experienced an error. See Diagnostic LED codes
on page 110

None

No light

System is in Hibernate, or it is off
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HP Insight Diagnostics Offline Edition
The diagnostics utility enables you to perform testing and to view critical computer hardware and
software configuration information from various sources. This utility enables you to:
●

Run diagnostics

●

View the hardware configuration of the system

Key features and benefits
HP Insight Diagnostics simplifies the process of effectively identifying, diagnosing, and isolating
hardware issues.
In addition to robust management tools, service tools can be invaluable in quickly resolving system
problems. To streamline the service process and resolve problems quickly, it is necessary to have the
right information available at the time that a service call is placed. The primary information requirement,
which is also the one that provides the greatest insight into potential system issues, is the configuration
of the system. Insight Diagnostics helps provide higher system availability. Typical uses of the Insight
Diagnostics are:
●

Testing and diagnosing apparent hardware failures

●

Documenting system configurations for upgrade planning, standardization, inventory tracking,
disaster recovery, and maintenance

●

Sending configuration information to another location for more in-depth analysis

Theory of operation
Insight Diagnostics Offline Edition operates in offline mode only. The operating system is not running
and software information from the system is not available to the diagnostics.
Offline Survey is available to display the current system configuration.
The Insight Diagnostics Test feature provides the capability to test functionality of all the major hardware
components in the system. The Test feature is designed with flexibility to enable you to customize test
selections by specifying different modes and types of testing.
A Quick Test provides a predetermined script where a sample of each hardware component is tested
and requires no user intervention.
A Complete Test provides a predetermined script during which each hardware component is fully tested.
You can select Interactive or Unattended tests. This changes the devices tested during the Complete
Test. There are more tests available in the interactive mode, but these require user intervention.
A Custom Test provides the most flexibility in controlling the testing of a system. The Custom Test mode
enables you to specifically select which devices, tests, and test parameters are run. You can select tests
that do not require any user interaction through the Interactive and Unattended tests modes.

Diagnostic utility on CD
HP Insight Diagnostics is available on the Documentation Library CD included with your workstation.
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To start the diagnostic utility on the Documentation Library CD:
1.

To enter the Computer Setup (F10) Utility, power on your workstation and press F10 during the
initial boot process .

2.

Select your language from the list and press the Enter key. In the Computer Setup Utilities menu,
four headings are displayed: File, Storage, Security, and Advanced. There might be other
headings, depending on your workstation.

3.

Use the right arrow key to select Storage.

4.

Use the down arrow key to select Boot Order, and then press Enter.

5.

Select CD-ROM Drive, and then press F5 to enable it as a bootable device. (If the CD drive is not
already enabled, pressing F5 again disables it.) The default setting is Enabled.

6.

Set the optical drive at the top of the boot order. To do this, select CD-ROM, press the Enter key,
and then use the up arrow to move it to the top of the boot order.

7.

To apply and save changes, press the F10 key, and then select File>Save Changes and Exit.

8.

Insert the Documentation Library CD into the workstation.

9.

Restart your system and HP Insight Diagnostics launches automatically.

Downloading the latest diagnostic utility
1.

Go to http://www.hp.com.

2.

Select the Support & Drivers link.

3.

Select the Download driver and software radio button.

4.

Enter your product number (for example, xw4600) in the text box, and then press Enter.

5.

Select your operating system.

6.

Select the Diagnostic link.

7.

Locate HP Insight Diagnostics Offline and select Download.

User Interface
Navigation
The Insight Diagnostics home page contains these tabs: Survey, Test, Status, Log, and Help. These
tabs separate the major functions of Insight Diagnostics.

Survey tab
When the Survey tab is selected, the Survey menu is displayed and enables you to view important
system configuration information. The Summary view limits the amount of data displayed, while the
Advanced view shows all the data in the selected category. Regardless of whether you choose
Advanced or Summary, the following categories of information are available on the Survey menu:
Overview—Provides a listing of general information about the computer.
All—Provides a listing of all information about the computer.
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Architecture—Displays the workstation bus type and BIOS information. In addition, if the bus is PCI,
information about the PCI configuration is displayed.
Asset Control—Displays the serial number of the computer and also provides processor information.
Communication—Displays information about the computer parallel (LPT) and serial (COM) port
settings, USB, and network controller information.
Graphics—Displays information about the graphics subsystem of the computer.
Input Devices—Displays information about the type of keyboard and mouse.
Memory—Displays information about all memory in the computer, including memory on the board and
any memory modules installed.
Miscellaneous—Displays information obtained from the computers configuration memory (CMOS),
BIOS data area, Interrupt Vector table, and diagnostics component information.
Storage—Displays information about storage media connected to the computer, including all fixed
disks, diskette drives, and optical drives.
System—Displays product type, processor type and speed, coprocessor information, and information
about all ROMs in the computer.

Test tab
The Insight Diagnostics utility provides the capability to test all the major hardware components in the
workstation. You can select from several types of tests:
Quick Test—Provides a predetermined script that samples most hardware components and requires
no user intervention.
Complete Test—Provides a predetermined script during which most hardware components are fully
tested. You can select Interactive or Unattended tests. This changes the devices tested during the
Complete Test. More tests are available in the interactive mode, but these require user intervention.
Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test mode
enables you to specifically select which devices, tests, and test parameters to run. You can select tests
that do not require any user interaction through the Interactive and Unattended test modes. More tests
are available in the interactive mode, but these tests require user intervention.
To begin diagnostics testing:
1.

Select the Test tab.

2.

Select Type of Test to perform, select Test Mode, and then select either Interactive or
Unattended.

3.

Choose how you want the test to be executed, either Number of Loops or Total Test Time.

4.
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●

When choosing to run the test over a specified number of loops, enter the number of loops to
perform.

●

If you want to run the diagnostic test for a specified time period, enter the amount of time in
minutes.

To start the test, select Begin Testing in the lower right corner of the display.
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While tests are performed, you can monitor the progress by viewing the Status tab. Any errors that are
detected are summarized in the Error Log. Select Save to save the report to a diskette or a USB key
drive (if attached).
If the diagnostics utility detects an error during a test, the user can mouse over the failed text in the
Status tab to display additional information about the type of error and the error code.
To view all test failure information, select Error Log. To view the status of all testing that has been
performed, select the Log tab.

Status tab
The Status tab displays the status of the selected tests. The type of test executed (for example, Quick,
Complete, or Custom) is displayed. The main progress bar displays the percentage of completion of the
current set of tests. While testing is in progress, the Cancel Testing button is displayed. Select this to
cancel the test.
After testing is complete, the Cancel Testing button is replaced with the Select New Tests and Retest
buttons. Select New Tests enables you to go back to the previous test selection page to select a new
set of tests. The Retest button retests the last set of tests executed. This enables you to rerun a set of
tests without having to go back to the test selection page.
The Status page also shows:
●

Devices being tested

●

Tests currently running

●

Overall test time

●

Individual test times

●

Condition status of each test

Log tab
The Log tab consists of the following views.
Test Log—Displays all tests that have been executed, number of times a test was executed, the number
of times a test failed, and the time it took to complete the test. The Clear Test Log button clears the
contents of the Test Log.
Error Log—Displays the tests that have failed during diagnostic testing. Besides displaying the device
and test, this section might also include error details. The description section describes the error that
the diagnostic test found. The Recommended Repair will give a recommended action that should be
performed to resolve the hardware problem. The error count is the number of times the test has failed.
The Clear Error Log button clears the contents of the Error Log.
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Help tab
The Help tab provides three views:
●

HP Insight Diagnostics—Provides introductory and detailed information about Insight Field
Diagnostics.

●

Error Codes—Provides error code listings, including devices tested, messages, and
recommended repair information.

●

Test Components—Reloads and refreshes all components and displays component details after
the refresh.

POST error messages
Power On Self Test (POST) is a program run at startup that initializes and runs tests on installed
hardware. An audible and/or visual message appears if the POST encounters a problem. POST checks
the following items to ensure that the workstation system is functioning properly:
NOTE: If the power-on password is set, a key icon appears on the screen while POST is running. You
must enter the password before continuing.
Table 5-18 POST error messages
Screen message

Probable cause

Recommended action

101—Option ROM Error

System ROM checksum

Verify the correct ROM:

102—System Board Failure

103—System Board Failure
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DMA, timers, and so on

DMA, timers, and so on

1.

Flash the ROM, if needed.

2.

If an expansion card was recently added, remove
it to find out if the problem remains.

3.

Clear CMOS. If the message disappears, there
might be a problem with the expansion card

4.

Replace the system board.

1.

Clear CMOS.

2.

Remove expansion boards.

3.

Replace the system board.

1.

Clear CMOS.

2.

Remove expansion boards.

3.

Replace the system board.

110—Out of Memory for
Option ROMs

Option ROM for a device was unable
to run due to memory constraints.

Run the Computer Setup (F10) Utility to enable the
ACPO/USB Buffers at Top of Memory under the
Advanced>Power-On option.

162—System Options Not Set

Configuration incorrect. RTC battery
might need replacement.

1.

Run Computer Setup (F10) Utility.

2.

Set the date and time from the Control Panel or in
the setup utility (depending on the operating
system).

3.

If the problem persists, replace the RTC battery.
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Table 5-18 POST error messages (continued)
Screen message

Probable cause

Recommended action

163—Time and Date Not Set

Invalid time or date in configuration
memory.

1.

Set the date and time from the Control Panel or in
the Computer Setup (F10) Utility (depending on
the operating system).

2.

If the problem persists, replace the RTC battery.

1.

Run the Computer Setup (F10) Utility or Windows
utilities.

2.

Verify that the memory modules (if any) are
installed properly.

3.

If third-party memory has been added, test using
HP memory only.

4.

Verify proper memory module type.

1.

Run the Computer Setup (F10) utiltiy or Windows
utilities.

2.

Be sure that memory and continuity modules are
installed correctly.

3.

Verify proper memory module type.

4.

Remove and replace memory modules one at a
time to isolate faulty modules.

5.

Replace faulty memory modules.

6.

If error persists after replacing memory modules,
replace the system board.

RTC battery might need replacement.
CMOS jumper might not be properly
installed.
164—Memory Size Error

201—Memory Error

202—Memory Type Mismatch

Memory configuration is incorrect.

RAM failure.

Memory modules do not match.

207—ECC Corrected Single
Single-bit ECC error.
Bit Errors in Memory Socket(s)
y,y

Replace memory modules with matched sets.
1.

Verify proper memory module type.

2.

Insert the DIMM in another memory socket.

3.

Replace memory module if problem persists.

1.

Reseat the processor in its socket.

2.

If the processor does not respond, replace it.

A memory module in memory socket
identified in the error message is
missing critical SPD information or is
incompatible with the chipset.

1.

Verify proper memory module type.

2.

Insert the DIMM in another memory socket.

3.

Replace module with a DIM conforming to the
SPD standard.

214—DIMM Configuration
Warning

DIMMs not installed correctly (not
paired correctly).

See the illustration on the side access panel for the
correct memory configurations, and reseat the DIMMs
accordingly.

215—Memory Mismatch
Warning

There are one or more mismatched
pairs of DIMMs between channel A and
channel B. Some memory has been
disabled. Install matching pairs or
remove the mismatched DIMMs from
channel B.

See the illustration on the side access panel for the
correct memory configurations, and reseat the DIMMs
accordingly.

212—Failed Processor

213—Incompatible memory
Module in memory Socket(s)
x,x

Processor has failed to initialize.
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Table 5-18 POST error messages (continued)
Screen message

Probable cause

Recommended action

216—Memory Size Exceeds
Maximum Supported

The amount of memory installed
exceeds that supported by the
hardware.

1.

Verify how much memory your system supports.

2.

Remove the excess memory.

219—ECC Memory Module
Detected.

ECC modules not supported on this
platform.

Remove the ECC module.

301—Keyboard Error

Keyboard failure.

1.

Reconnect the keyboard with the workstation
powered off.

2.

Check the connector for bent or missing pins.

3.

Be sure that none of the keys are pressed.

4.

Replace the keyboard.

1.

Reconnect keyboard with workstation turned off.

2.

Replace the system board.

1.

Reconnect the keyboard with workstation turned
off.

2.

Be sure that none of the keys are pressed.

3.

Replace keyboard.

4.

Replace system board.

303—Keyboard Controller
Error
304—Keyboard or System
Unit Error

I/O board keyboard controller.

Keyboard failure.

411—Network Interface Card
Interrupt Conflict

IRQ address conflicts with another
device.

Reset the IRQ.

501—Display Adapter Failure

Graphics display controller.

1.

Reseat the graphics card (if applicable).

2.

Clear CMOS.

3.

Verify that the monitor is attached and turned on.

510—Splash Screen image
corrupted

Splash Screen image has errors.

To restore the image, install the latest SoftPaq.

511—CPU, CPUA, or CPUB
Fan not detected

Fan is not connected, or might have
malfunctioned.

1.

Reseat the fan cable.

2.

Reseat the fan.

3.

Replace the fan.

1.

Reseat the chassis, rear chassis, or front chassis
fan cable.

2.

Reseat the chassis, rear chassis, or front
chassis fan.

3.

Replace the chassis, rear chassis, or front
chassis fan.

1.

Reseat the processor or chassis fan.

2.

Replace the processor or chassis fan.

1.

Run the Computer Setup (F10) utiltiy.

2.

Verify and replace cables.

3.

Clear CMOS.

512—Chassis, rear chassis, or Fan is not connected, might have
front chassis fan not detected malfunctioned.

514—CPU or Chassis Fan not Processor fan is not connected or
detected
might have malfunctioned.
601—Diskette Controller Error
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Diskette controller circuitry or diskette
drive circuitry incorrect.
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Table 5-18 POST error messages (continued)
Screen message

605—Diskette Drive Type
Error

Probable cause

Mismatch in drive type.

Recommended action
4.

Replace diskette drive.

5.

Replace the system board.

1.

Run the Computer Setup (F10) Utility.

2.

Disconnect any other diskette controller devices
(tape drives).

3.

Clear CMOS.

912—Computer Cover Has
Been Removed Since Last
System Start Up

N/A

No action required.

914— Coil is not Connected

Mechanism is missing or not
connected.

1.

Reconnect or replace ing mechanism.

2.

Reseat or replace ing mechanism cable.

916—Power Button Not
Connected

The power button is not connected.

Connect power button.

917—Front Audio Not
Connected

The front audio cable is not connected.

Connect front audio cable.

918—Front USB Not
Connected

Front USB is not connected.

Connect front USB cable.

960—CPU Overtemp
occurred

The ambient temperature could
exceed operating limits
(maximum=95F), or there are
obstructions to airflow, including dust
buildup.

1.

Be sure you are not operating the system in an
environment that exceeds 95F.

2.

Disconnect power and open the access panel.

3.

Verify that cables are not blocking processor
heatsink fans or front fan (if installed).

4.

Verify that there is not excessive dust on major
components.

5.

If airflow is acceptable and there is not excessive
dust, the thermal sensing circuitry has failed on the
processors or on the system board. You must
replace the processors and/or the system board.

1.

Determine if hard drive is giving correct error
message.

2.

Run the Drive Protection System test (if
applicable).

3.

Apply firmware patch (if applicable).
See http://www.hp.com/support.

4.

Back up contents and replace the hard drive.

1.

Be sure that any jumpers are set correctly, and
that power and drive cables are connected, both
to the drive and the system board.

2.

Verify that the cables are the correct cables for
your computer model. If this message persists,
your workstation might require service.

1720—SMART Hard Drive
Detect Imminent Failure

1780—Disk 0 Failure

Hard drive is about to fail. (Some hard
drives have a firmware patch that fixes
erroneous error messages.)

The drive is not installed correctly or
has failed.
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Table 5-18 POST error messages (continued)
Screen message

Probable cause

Recommended action

1781—Disk 1 Failure

The drive is not installed correctly or
has failed.

1.

Be sure that any jumpers are set correctly and that
power and drive cables are connected, both to the
drive and the system board.

2.

Verify that the cables are the correct cables for
your computer model. If this message persists,
your workstation might require service.

1.

Run the Computer Setup (F10) utiltiy.

2.

Clear CMOS.

3.

Verify cable seating and jumper settings.

4.

Run hard-drive diagnostics.

5.

Disconnect additional drives.

6.

Run the Drive Protection System test (if available).

7.

Replace the hard drive.

8.

Replace the system board.

1.

Be sure that any jumpers are set correctly and that
power and drive cables are connected to both the
hard drive and the system board.

2.

Verify that the cables are the correct cables for
your computer model. If this message persists,
you may need service for your workstation.

1.

Be sure that any jumpers are set correctly and that
power and drive cables are connected to both the
hard drive and the system board.

2.

Verify that the cables are the correct cables for
your computer model. If this message persists,
you may need service for your workstation

1.

Run the Computer Setup (F10) utilty.

2.

Clear CMOS.

3.

Verify cable seating/jumper settings.

4.

Run hard-drive diagnostics.

5.

Disconnect additional drives.

6.

Run the Drive Protection System test (if available).

7.

Replace the hard drive.

1.

Run the Computer Setup (F10) Utility.

2.

Clear CMOS.

3.

Verify cable seating and jumper settings.

4.

Run hard-drive diagnostics.

5.

Disconnect additional drives.

1782—Disk Controller Failure

1790—Disk 0 Error

1791—Disk 1 Error

1792—Secondary Disk
Controller Failure

1793—Secondary Controller
or Disk Failure

ENWW

Hard drive circuitry error.

The drive is not installed correctly or
has failed.

The drive is not installed correctly or
has failed.

Hard drive circuitry error.

Hard drive circuitry error.
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Table 5-18 POST error messages (continued)
Screen message

Probable cause

Recommended action
6.

Run the Drive Protection System test (if available).

7.

Replace the hard drive.

1801—Microcode Patch Error

Processor not supported by ROM
BIOS.

Upgrade BIOS to proper version.

1802—Processor Not
Supported

The system board does not support the
processor.

Replace the processor with a compatible one.

1803-BIOS Update Needed for This BIOS revision does not support
Processor
the installed processor.

Install the latest BIOS downloaded from
http://www.hp.com.

1998—Master Boot Record
has been lost

The previously saved copy of the MBR Run the Computer Setup (F10) Utility and save the
is corrupted.
MBR of the current bootable disk.

Invalid Electronic Serial
Number

Electronic serial number is corrupted

1.

Run the Computer Setup (F10) Utility.

2.

If the setup utility already has data in the field, or
it will not allow the serial number to be entered,
see http://www.hp.com.

3.

Download and run the sp5572.exe (snzero.exe)
utility.

4.

Run the Computer Setup (F10) Utility again and
try to enter the serial number under
Security>System ID.

5.

Ssave the changes.

ECC Multiple Bit Error
Detected in Memory Module

The chipset has detected more than
one bad bit in a 64-bit quadword of the
memory array.

Replace the memory module.

Parity Check 2

Parity RAM failure.

Run the Computer Setup (F10) Utility and the
Diagnostic utilities.
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6

Configuring RAID devices

This chapter describes how to configure SAS and SATA RAID devices:
●

Configuring SAS RAID devices on page 141

●

Configuring SATA RAID devices on page 144

For additional information about configuring RAIDs, see http://www.hp.com/support/RAID_FAQs. For
information about preparing your workstation for RAID configuration, see http://www.hp.com/support/
workstation_manuals.

Configuring SAS RAID devices
Supported configurations
The following RAID configurations are supported on the HP xw4600 Workstation.
NOTE: This section does not apply to configuring RAID in the Linux environment. For RAID in the
Linux environment, configure RAID configurations as provided by Red Hat Enterprise Linux.
●

Up to four internal SAS hard disk drives

●

SAS to SATA data and power converter

●

LSI MegaRAID Storage Manager (MSM) for Windows

The following RAID configurations are supported on the HP xw4600 Workstation:
●

●
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RAID 0 – Striped disk array
◦

Two drive minimum

◦

Improved I/O performance

◦

No fault tolerance

RAID 1 — Mirrored disk array
◦

Two drives

◦

100% redundancy
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●

◦

Can recover from single drive failure

◦

Improved read performance

RAID 1E
◦

Three drives minimum

◦

Can be an odd number of drives

◦

Can always recover from a single drive failure and, in some cases, can recover from two drive
failures

SAS RAID 0 configuration
Follow the steps below to configure an Integrated Striped (IS) volume with the BIOS-based configuration
utility. The configuration procedure assumes that the system already has the required disk and disk
controllers.
1.

On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

2.

Press Enter to go to the Adapter Properties screen.

3.

On the Adapter Properties screen, use the arrow keys to select RAID Properties.

4.

Press Enter to go to the RAID Properties screen.

5.

In the RAID Properties screen, use the arrow keys to select the first disk for the IS volume. Then
use the arrow keys to move to the Array Disk column for this disk, and press the SPACE, +, or key to select Yes as the value for this column. If partitions are defined on the selected disk, a
message appears warning you that data on the disk will be lost when the striped volume is created.
Press the M key to migrate, or the D key to delete the data on the drive.

6.

Repeat the previous step to select up to three more disks for the striped volume.

7.

Press the C key to create the array once all drives have been chosen, then press Esc and
select Save.

SAS RAID 1 configuration
Follow the steps below to configure an Integrated Mirroring (IM) volume with the BIOS-based
configuration utility. The configuration procedure assumes that the system already has the required disk
and disk controllers.
1.

On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

2.

Press Enter to go to the Adapter Properties screen.

3.

On the Adapter Properties screen use the arrow keys to select RAID Properties.

4.

Press Enter to go to the RAID Properties screen. .

5.

Chose one of the following options:
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To configure a two-disk mirrored volume with an optional hot spare disk:
●

In the RAID Properties screen, use the arrow keys to select the primary disk for the IM volume
(the disk with the data you want to mirror.)

●

Use the arrow keys to move to the Array Disk column for this disk and use the SPACE key to
select Yes as the value. If partitions are defined on the selected disk, a message appears
warning you that data on the disk will be lost when the striped volume is created. Press the
M key to migrate, or the D key to delete the data on the drive.

●

When the Keep Data/Erase Disk message appears, press F3 to keep the data currently on
this disk. The value in the Array Disk column changes to Primary.

●

Use the arrow keys to select the secondary (mirrored) disk for the IM volume. Select Yes as
the value for the Array Disk column.
If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk. Continue with Step 6.

SAS RAID 1E configuration
Follow the steps below to configure an Integrated Mirroring Extended (IME) volume with the BIOS-based
configuration utility. The configuration procedure assumes that the system already has the required disk
and disk controllers.
1.

On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

2.

Press Enter to go to the Adapter Properties screen.

3.

On the Adapter Properties screen use the arrow keys to select RAID Properties on the screen.

4.

Press Enter to go to the RAID Properties screen. Continue with Step 5 to configure a two-disk
mirrored volume. Go to Step 6 to configure a mirrored volume with three to six disks.

5.

To configure a mirrored volume with three to six disks, or three to five disks with an optional hot
spare disk:
●

In the RAID Properties screen, use the arrow keys to select the first disk for the IME volume.

●

Use the arrow keys to move to the Array Disk column for this disk, and use the + and - keys
to select Yes as the value.

●

When the Keep Data/Erase Disk message appears, press Delete to erase the disk.

●

Use the arrow keys to select the next disk for the IME volume. Select Yes as the value for the
Array Disk column.
If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk.

●
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Repeat the previous steps to select up to four more disks for the IME volume. If you want to
configure a hot spare disk for the volume, you can only select up to three more disks.
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6.

(Optional) Use the arrow keys to select a hot spare disk for the IME volume. Select Yes as the
value for the Hot Spare column.

7.

When you have selected all disks for the IME volume, press Esc and select Save changes, then
exit this menu. If you do not want to create the IME volume, select Discard changes, then exit
this menu.
The IME volume exists as soon as you save the changes. The RAID Properties screen now displays
the IME volume properties and status.

Configuring SATA RAID devices
This section describes how to use the Intel Matrix Storage Manager option ROM Configuration utility to
set up and manage SATA RAID volumes.
NOTE: If only a single HDD is attached, the Intel Matrix Storage Manager option ROM will not execute.
All associated messages will not be displayed.
The Intel SATA AHCI BIOS always executes when RAID/AHCI is selected for the SATA emulation mode.
This BIOS is only used to support serial attached optical drives. When an HDD is attached, the AHCI
BIOS properly identifies the HDD that is connected to the appropriate SATA port and displays Device
not supported in this configuration. This message is expected and does not indicate a problem.

Attaching SATA HDDs
Attach the required number of SATA hard drives for the desired RAID level.
●

RAID 0: two to three hard drives

●

RAID 1: two hard drives

●

RAID 5: three hard drives

●

RAID 10: four hard drives

Configuring system BIOS
Configure the system BIOS to enable embedded SATA RAID functionality.
1.

Press F10 to enter the system BIOS setup.

2.

Use the arrow keys to highlight the desired language, then press Enter.

3.

Use the arrows on your keyboard to highlight Storage>Storage Options, then press Enter.

4.

Use the up or down arrow key to highlight SATA Emulation.

5.

Use the left or right arrow key to select RAID/AHCI.

6.

Press F10 to accept the new setting.

7.

Use the arrows on your keyboard to highlight Advanced > Power-On Options, then press
Enter.

8.

Use the up or down arrow key to highlight POST Messages.

9.

Use the left or right arrow key to select Enable.
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10. Press F10 to accept the new setting.
11. Use the arrow keys to highlight Advanced>Device Options, and press Enter.
12. Use the up or down arrow key to highlight SATA RAID Option ROM Download, and press
Enter.
13. Use the left or right arrow key to select Enable.
14. Press F10 to accept the new setting.
15. Use the arrows on your keyboard to highlight File>Save Changes and Exit, and press Enter.
16. Press F10 when prompted.

Creating RAID volumes
Use the Intel Matrix Storage Manager option ROM Configuration utility to create RAID volumes.
1.

Press Ctrl+I when prompted to enter the Intel Matrix Storage Manager option ROM Configuration
utility.

2.

If required, see Deleting RAID volumes on page 145 to make enough physical drives available to
create the desired RAID volume.

3.

Use the up or down arrow key to highlight 1. Create RAID Volume, and press Enter.

4.

Type the desired RAID volume name in the “Name:” field, and press Tab.

5.

Use the up or down arrow key to select the desired RAID level in the RAID Level: field, then
press Tab.

6.

Press Enter to display the Select Disks dialog.

7.

Use the up and down arrow keys and Space to mark individual physical disks as members of the
volume.

8.

Press Enter to exit the Select Disks dialog and return to the Create Volume Menu dialog.

9.

If appropriate, use the up or down arrow key to select the Strip Size in the Strip Size: field, and
press Tab.

10. Type the desired volume size in the Capacity: field, and press Tab.
11. Press Enter to initiate volume creation.
12. When prompted, press Y to acknowledge the warning message and create the volume.
13. Return to step 3 to create additional RAID volumes, or use ? or ? to highlight 4. Exit, and press
Enter.
14. Press Y when prompted to confirm the exit.

Deleting RAID volumes
Use the Intel Matrix Storage Manager option ROM Configuration utility to delete RAID volumes.
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1.

Use the up or down arrow key to highlight 2. Delete RAID Volume, and press Enter.

2.

Use the up or down arrow key to highlight the RAID volume to be deleted, and press Del.
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3.

When prompted, press Y to confirm the deletion of the selected RAID volume.

4.

Choose one of the following steps:
●

Return to step 1 to delete additional RAID volumes.

●

To create RAID volumes, see Creating RAID volumes on page 145.

●

Use the up or down arrow key to highlight 4. Exit, and press Enter.

●

Use the up or down arrow key to highlight 3. Reset Disks to Non-RAID, and press Enter.

5.

Use the up and down arrow keys and Space to mark individual physical disks to be reset.

6.

Press Enter to complete the selection.

7.

When prompted, press Y to confirm the reset action.

8.

Choose one of the following steps:
●

Return to step 1. to delete additional RAID volumes.

●

To create RAID volumes, see Creating RAID volumes on page 145.

●

Use the up or down arrow key to highlight 4. Exit, and press Enter.
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7

Configuring password security and
resetting CMOS

This chapter describes how to configure password security and to reset CMOS, and includes these
topics:
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●

Preparing to configure passwords on page 148

●

Resetting the password jumper on page 149

●

Resetting the password jumper on page 149

147

Preparing to configure passwords
The Computer Setup (F10) Utility enables you to create setup and power-on passwords.
When you create a setup password, only the power-on password is required to access the Computer
Setup (F10) Utility and any other information on the workstation. When you create both passwords, only
the setup password gives you access to the Computer Setup (F10) Utility.
When both passwords are created, the setup password can also be used in place of the power-on
password as an override to log into the workstation (a useful feature for a network administrator).
If you forget a password, two methods are available for clearing the password to gain access to the
information on the workstation:
●

Reset the password jumper

●

Press the Clear CMOS button

CAUTION: Pressing the Clear CMOS button resets CMOS values to factory defaults and erases any
customized information, including passwords, asset numbers, and special settings. It is important to
back up your workstation CMOS settings before resetting them in case they are necessary later. To
back up the CMOS settings, run the Computer Setup (F10) Utility and select Save to Diskette from the
File menu.
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Resetting the password jumper
To disable the power-on or setup password features and clear the power-on and setup passwords:
WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to
disconnect the power cord from the wall outlet and allow the internal system components to cool before
touching.
CAUTION: When the workstation is plugged in, the power supply always has voltage applied to the
system board even when the workstation is turned off. Failure to disconnect the power cord can result
in damage to the system.
CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity by
briefly touching a grounded metal object.
1.

Shut down the operating system, and then power off the workstation and any external devices.
Disconnect the workstation power cord and any external devices from the power outlets.

2.

Disconnect the keyboard, monitor, and any other external devices that are connected to the
workstation.

3.

Remove the access panel.

4.

Locate the password header and jumper. The password header is E49.
NOTE: Ensure that the AC power cord is disconnected from the power outlet. The CMOS button
does not clear CMOS if the power cord is connected.
The password jumper is green so that it can be easily identified. For assistance locating the
password jumper and other system board components, see the service label located on the inside
of the workstation access panel, or see System board components on page 59.
.
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5.

Remove the jumper from either pin 1 or 2. Place the jumper on pins 1 and 2 (connecting both pins
together).

6.

Replace the access panel.

7.

Reconnect the external equipment.

8.

Plug in and power on the workstation. Allow the operating system to start. This process clears the
current passwords and disables the password features.

9.

To establish new passwords, repeat steps 1 through 4, replace the password jumper on either pin
1 or pin 2 (but not both), and repeat steps 6 through 8. Establish the new passwords using the
Computer Setup (F10) Utility.
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Clearing and Resetting the CMOS
The CMOS of the workstation stores password information and information about the workstation
configuration. This section describes the steps necessary to successfully clear and reset the CMOS.

Using the CMOS Button
Follow the steps below to clear CMOS using the Clear CMOS button:
WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to
disconnect the power cord from the wall outlet and allow the internal system components to cool before
touching.
CAUTION: When the workstation is plugged in, the power supply always has voltage applied to the
system board even when the workstation is powered off. Failure to disconnect the power cord can result
in damage to the system
CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity by
briefly touching a grounded metal object.
1.

Shut down the operating system, and then power off the workstation and any external devices.
Disconnect the workstation power cord and any external devices from the power outlets.

2.

Disconnect the keyboard, monitor, and any other external devices that are connected to the
workstation.

3.

Remove the access panel.
CAUTION: Pushing the Clear CMOS button resets CMOS values to factory defaults and erases
any customized information, including passwords, asset numbers, and special settings. It is
important to back up the workstation CMOS settings before resetting them in case they are
necessary later. To back up the CMOS settings, use the Computer Setup (F10) Utility and
select Save to Diskette from the File menu.

4.

Locate, press, and hold the CMOS button for five seconds.
NOTE: Be sure that the AC power cord is disconnected from the power outlet. The CMOS button
does not clear CMOS if the power cord is connected.
NOTE: For assistance locating the CMOS button and other system board components, see
System board components on page 59.

5.

Replace the access panel.

6.

Reconnect any external devices.

7.

Plug in and power on the workstation.
NOTE: The workstation passwords and any special configuration information, including the
system date and time, must be reset.

The workstation powers up for three to five seconds, then powers down.
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Using the Computer Setup (F10) Utility to Reset CMOS
1.

Access the Computer Setup (F10) Utility menu. When the Computer Setup message appears in
the lower-right corner of the screen, press F10. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key while the message is displayed, the workstation must be
powered off, then on again, to access the utility.

2.

From the Computer Setup (F10) Utility menu, select File>Set Defaults, and then select Exit. This
restores the settings that include boot sequence order and other factory settings. However, it does
not force hardware rediscovery.
NOTE: The workstation passwords and any special configuration information, including the
system date and time, must be reset.
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Appendix A—Connector pins

Connector pin descriptions
Workstation

Pin

Signal

Workstation keyboard connector

Workstation mouse connector

ENWW

1

Data

2

Unused

3

Ground

4

+5 VDC

5

Clock

6

Unused

Pin

Signal

1

Data

2

Unused

3

Ground

4

+5 VDC

5

Clock

6

Unused
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Workstation Ethernet connector

Pin

10/100–MbSignal

1000–Mb
signal

1

(+) Transmit Data

TX/RX

0

+

2

(-) Transmit Data

TX/RX

0

–

3

(+) Receive Data

TX/RX

1

+

4

Unused

TX/RX

2

+

RX/RX

2

–

TX/RX

1

–

TX/RX

3

+

TX/RX

3

–

5
Unused
6
(-) Receive Data
7
Unused
8
Unused

Workstation parallel connector

Pin

Signal

Pin

Signal

Pin

Signal

1

Strobe

7

Data Bit 5

13

Select

2

Data Bit 0

8

Data Bit 6

14

Auto Linefeed

3

Data Bit 1

9

Data Bit 7

15

Error

4

Data Bit 2

10

Acknowledge

16

Initialize Printer

5

Data Bit 3

11

Busy

17

Select IN Signal

6

Data Bit 4

12

Paper End

Workstation serial connector
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18-25

Ground

Pin

Signal

1

Carrier Detect

2

Receive Data

3

Transmit Data

4

Data Terminal Ready

5

Signal Ground

6

Data Set Ready

7

Request to Send

8

Clear to Send

9

Ring Indicator
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Workstation USB connector

Workstation IEEE 1394 connector

Microphone cable connector (1/8 inch)

Headphone cable connector (1/8 inch)

Line-in audio cable connector (1/8 inch)

Line-out audio cable connector (1/8 inch)

ENWW

Pin

Signal

1

+5 VDC

2

- Data

3

+ Data

4

Ground

Pin

Signal

1

Power

2

GND

3

TPB-

4

TPB+

5

TPA-

6

TPA+

Pin

Signal

1 (Tip)

Audio

2 (Ring)

Power

3 (Shield)

Ground

Pin

Signal

1 (Tip)

Audio_Left

2 (Ring)

Audio_Right

3 (Shield)

Ground

Pin

Signal

1 (Tip)

Audio_In_Left

2 (Ring)

Audio_In_Right

3 (Shield)

Ground

Pin

Signal

1 (Tip)

Audio_Out_Left

2 (Ring)

Audio_Out_Right
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Line-out audio cable connector (1/8 inch)

Pin
3 (Shield)

Signal
Ground

SATA drive connector

Pin

Signal
Data Cable

Pin

Signal

Power Cable

Pin

Signal

Power Cable

S1

Ground

P1

3.3V power

P8

5V power

S2*

A+

P2

3.3V power

P9

5V power

S3*

A-

P3

3.3V power

P10

Ground

S4

Ground

P4

Ground

P11

Reserved

S5**

B-

P5

Ground

P12

Ground

S6**

B+

P6

Ground

P13

12V power

Ground

P7

5V power

P14

12V power

P15

12V power

S7

* S2 and S3 differential signal pair
**S5 and S6 differential signal pair

SAS drive connector

Segment

Primary signal segment

Pin

S1

Backplane
receptacle

Plug and
cable
receptacles

SIGNAL GROUND

S2

TP+

RP+

S3

TP-

RP-

S4

SIGNAL GROUND

S5

RP-

TP-

S6

RP+

TP+

S7
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SAS drive connector

Segment

Secondary signal segment

Pin

Backplane
receptacle

S8

SIGNAL GROUND

S9

TS+

RS+

S10

TS-

RS-

S11

SIGNAL GROUND

S12

RS-

TS-

S13

RS+

TS+

S14
Power segment
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Plug and
cable
receptacles

SIGNAL GROUND

P1

V33c

P2

V33c

P3

V33c precharge c

P4

GROUND

P5

GROUND

P6

GROUND

P7

V5c precharge c

P8

V5c

P9

V5c

P10

GROUND

P11

READY LED d

P12

GROUND

P13

V12 precharge c

P14

V12c

P15

V12c
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Workstation VGA connector

Pin

Signal

Pin

Signal

Pin

Signal

1

Red Analog

6

GND

11

Monitor ID

2

Green Analog

7

GND

12

DDC Serial Data

3

Blue Analog

8

GND

13

Horizontal Sync

4

Monitor ID

9

+5 VDC

14

Vertical Sync

5

GND

10

GND

15

DDC Serial Clock

DVI-I cable connector

Pin

Signal

Pin

Signal

1

T.M.D.S DATA 2-

16

HOT PLUG DETECT

2

T.M.D.S DATA 2+

17

T.M.D.S DATA 0-

3

T.M.D.S DATA 2/4 SHIELD

18

T.M.D.S DATA 0+

4

T.M.D.S DATA 4-

19

T.M.D.S DATA 0/5 SHIELD

5

T.M.D.S DATA 4+ 2

0

T.M.D.S DATA 5-

6

DDC CLOCK

21

T.M.D.S DATA 5+

7

DDC DATA

22

T.M.D.S CLOCK SHIELD

8

ANALOG VERT. SYNC

23

T.M.D.S CLOCK+

9

T.M.D.S DATA 1-

24

T.M.D.S CLOCK-

10

T.M.D.S DATA 1+

11

T.M.D.S DATA 1/3 SHIELD

C1

ANALOG RED

12

T.M.D.S DATA 3-

C2

ANALOG GREEN

13

T.M.D.S DATA 3+

C3

ANALOG BLUE

14

+5V POWER

C4

ANALOG HORZ SYNC

15

GND

C5

ANALOG GROUND
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24-pin main power cable connector

13

24

1

12

1

+3.3V

7

GND

13

+3.3V

19

GND

2

+3.3V

8

POK

14

-12V

20

GND

3

GND

9

+5 Vaux

15

GND

21

+5V

4

+5V

10

+12 V-B

16

PS_ON_L

22

+5V

5

GND

11

+12 V-B

17

GND

23

Unused

6

+5V

12

Unused

18

GND

24

GND

4-pin power (CPU/memory/aux. sys.
board) cable connector

6-pin power (auxiliary PCI Express)
cable connector

4

1

6

3

Pin

Color

Signal

1

BLK

GND

2

BLK

GND

3

WHT

+12 VCPU

4

WHT

+12 VCPU

Pin

Color

Signal

1

YEL

+12 V-D

2

YEL

+12 V-D

3

YEL

+12 V-D

4

BLK

GND

5

BLK

GND

6

BLK

GND

CAUTION: Ensure that you can differentiate between which power cable
connects to the PCI Express x16 graphics card and which power cable connects
to the system board. These two cables have different pin counts and different
colors. The PCI Express power cable has a 6-pin black connector, and the system
board power cable has an 4-pin white connector. When power is present, you
must never connect the PCI Express power cable to the system board. If you do
so, the system board can be damaged and your warranty voided. To see a picture
of the PCI Express cable and where it must be connected, see PCI Express
cards on page 81.
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6-pin power (auxiliary PCI Express)
cable connector

Pin

Color

Signal

NOTE: The 6-pin power (auxiliary PCI Express) is only required with highpowered graphics cards.

Workstation AUX_IN connector

Internal USB system board 2x5
connector

CAUTION: Possible equipment damage.

Pin

Signal

1

AUX_LEFT

2

AGND

3

AGND

4

AUX_RIGHT

Pin

Signal

1

+5V

2

+5V

3

USB6#

4

USB7#

5
USB6

The 2x5 system board connector can be
mated to either a wide 2x5 option cable
connector or a narrow 1x5 option cable
connector.
To prevent damage to the connectors,
always connect a narrow 1x5 option cable
connector to pins 1,3,5, and 7 only of the
2x5 system board connector (pin 9 is not
keyed on the system board connector).

6
USB7
7
GND
8
GND
9
(not keyed)
10
Not connected
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Workstation processor, PCI, and rear
chassis fan connector

Workstation FDD connector

ENWW

Pin

Signal

1

Ground

2

+12V

3

Tach

4

CMD

5

MT

Pin

Signal

Pin

Signal

1

Ground

18

FLP_DIR#

2

FLP_LOWDEN#

19

Ground

3

Tach

20

FLP_STEP#

4

FLP_WDO

21

Ground

5

MT

22

FLP_STEP#

6

Unused

23

Ground

7

Ground

24

FLP_WRTEN#

8

FLP_INDEX#

25

Ground

9

Ground

26

FLP_TRACK#

10

FLP_MOTOR#

27

Ground

11

Ground

28

FLP_WP#

12

Unused

29

Ground

13

Ground

30

FLP_RD_D#

14

FLP_SEL_A#

31

Ground

15

Ground

32

FLP_HD_SEL#

16

Unused

33

Ground

17

Ground

34

FLP_DSKCHG#
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Workstation

Pin

Signal

Pin

Signal

internal serial connector
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1

DTR2#

9

+5V

2

RXD2

10

+3.3V AUX

3

CTS2#

11

RTS2#

4

DSR2#

12

+3.3V

5

TXD2

13

DCD2#

6

+3.3V AUX

14

-12V

7

Ground

15

+12V

8

Ground
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Appendix B—System board
designators

This appendix lists the system board designators for this system.
Designator

Silkscreen

Component

MTG1-MTG10

N/A

Mounting holes

E14

E14

Boot block header/jumper

E49

E49

Clear password header/jumper

J20

SLOT 5 PCI

PCI slot

J21

SLOT 6 PCI

PCI slot

J22

Slot 7 PCI

PCI slot

J33

SLOT 3 PCIe x8 (4)

PCI Express slot

J31

SLOT1 PCIe x1

PCI Express slot

J32

SLOT4 PCIe2 x16 75W + 75W

PCI Express slot

J41

SLOT2 PCIe2 x16 75W + 75W

PCI Express slot

P60-64

SATA0 – SATA4

SATA Connectors

CN6

CN6

External SATA

J50, P53

PARALLEL/SERIAL

Parallel port and serial port stack connector

P52

P52

Optional serial port

J68

KBD_MS

Stacked keyboard/mouse connector

J9

J9

Stacked RJ 45/dual USB

J10

QUAD USB

Quad stacked USB

CN7

USB

Single vertical USB

J83

J83

Triple stacked audio jack

SW50

CMOS

Clear CMOS switch/push button

P1

P1

Power supply connector (24-pin)

P3

PWRCPU

Processor power

P10

FDD

Diskette driver connector

P11

AUX-IN

Auxiliary audio connector
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Designator

Silkscreen

Component

P23

FRNT AUDIO

Front panel audio header

P24

FRNT USB

Front panel USB header

P25

INT USB

Internal USB header

U1037

U1037

Internal Type A USB

P29

P29

HDD LED connector

P5

CONTROL PANEL

Main power/HDD LED/internal speaker
connector

P70

CPU FAN

Primary processor fan header

P8

SYS FAN

Chassis fan header

P9

PCI FAN

PCI fan header

XBT1

BATTERY

Battery retainer

XMM1

DIMM1

Memory slot

XMM2

DIMM3

Memory slot

XMM3

DIMM2

Memory slot

XMM4

DIMM4

Memory slot

U1

XU1

Primary processor socket

E15

E15

Crisis recovery header/jumper
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Appendix C—Routine care

General cleaning safety precautions

ENWW

●

Never use solvents or flammable solutions to clean the workstation.

●

Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

●

Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

●

Always disconnect the keyboard before cleaning it.

●

Wear safety glasses equipped with side shields when cleaning the keyboard.

General cleaning safety precautions 165

Cleaning the workstation case
●

Follow the service consideration (Service considerations on page 53) presented before cleaning
the workstation.

●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

●

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol
evaporates quickly and does not leave a residue.

●

After cleaning, always wipe the workstation with a clean, lint-free cloth.

●

Occasionally, clean the air vents on the workstation. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the keyboard
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under
the keys.
●

Follow the safety precautions presented in Service considerations on page 53 before cleaning the
keyboard.

●

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

●

Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

●

If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.
CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

●

Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not
to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

●

Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
●

Follow the safety precautions presented in Service considerations on page 53 before cleaning the
monitor.

●

To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or
a clean cloth moistened with water.
CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.
Never use solvents or flammable liquids on the monitor because display or housing damage may
result.
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Cleaning the mouse
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1.

Follow the safety precautions presented in Service considerations on page 53 before cleaning the
mouse.

2.

Remove the mouse ball from the housing by removing the retaining plate.

3.

Clean the mouse ball.

4.

Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5.

Reassemble the mouse.
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